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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

 WARNING 
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

 CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 

 NOTICE 
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

 WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Technical support  
 
Country Hotline 
China +86 400 810 4288 
Germany +49 911 895 7222 
Italy +39 (02) 24362000 
India +91 22 2760 0150 
Turkey +90 (216) 4440747  
Further service contact information:  
Support contacts (http://support.automation.siemens.com/WW/view/en/16604999) 

 

http://support.automation.siemens.com/WW/view/en/16604999
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 Safety instructions 1 
1.1 Fundamental safety instructions 

1.1.1 General safety instructions 
 

 WARNING 

Risk of death if the safety instructions and remaining risks are not carefully observed  

If the safety instructions and residual risks are not observed in the associated hardware 
documentation, accidents involving severe injuries or death can occur. 
• Observe the safety instructions given in the hardware documentation. 
• Consider the residual risks for the risk evaluation. 

 

 

 WARNING 

Danger to life or malfunctions of the machine as a result of incorrect or changed 
parameterization 

As a result of incorrect or changed parameterization, machines can malfunction, which in 
turn can lead to injuries or death. 
• Protect the parameterization (parameter assignments) against unauthorized access. 
• Respond to possible malfunctions by applying suitable measures (e.g. EMERGENCY 

STOP or EMERGENCY OFF). 
 



Safety instructions  
1.1 Fundamental safety instructions 

 SINAMICS V-ASSISTANT Online Help 
10 Operating Manual, 07/2015, A5E32187373-004 

1.1.2 Industrial security 
 

 Note 
Industrial security 

Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, solutions, machines, equipment and/or networks. They are 
important components in a holistic industrial security concept. With this in mind, Siemens’ 
products and solutions undergo continuous development. Siemens recommends strongly 
that you regularly check for product updates. 

For the secure operation of Siemens products and solutions, it is necessary to take suitable 
preventive action (e.g. cell protection concept) and integrate each component into a holistic, 
state-of-the-art industrial security concept. Third-party products that may be in use should 
also be considered. For more information about industrial security, visit this address 
(http://www.siemens.com/industrialsecurity).  

To stay informed about product updates as they occur, sign up for a product-specific 
newsletter. For more information, visit this address (http://support.automation.siemens.com).  

 

 WARNING 

Danger as a result of unsafe operating states resulting from software manipulation 

Software manipulation (e.g. by viruses, Trojan horses, malware, worms) can cause unsafe 
operating states to develop in your installation which can result in death, severe injuries 
and/or material damage. 
• Keep the software up to date. 

You will find relevant information and newsletters at this address 
(http://support.automation.siemens.com).  

• Incorporate the automation and drive components into a holistic, state-of-the-art 
industrial security concept for the installation or machine. 
You will find further information at this address 
(http://www.siemens.com/industrialsecurity).  

• Make sure that you include all installed products into the holistic industrial security 
concept. 

 

http://www.siemens.com/industrialsecurity
http://support.automation.siemens.com/
http://support.automation.siemens.com/
http://www.siemens.com/industrialsecurity
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 SINAMICS V-ASSISTANT 2 
 

 

 
SINAMICS V-ASSISTANT engineering tool is designed for faster commissioning and 
diagnostics for SINAMICS V90 drive. The software runs on a personal computer with 
Windows operating systems and utilizes graphical user interface to interact with users and 
communicates with V90 drive via USB. It can be used to modify parameters and monitor 
status of SINAMICS V90 drive. 

2.1 SINAMICS V-ASSISTANT operating environment 
SINAMICS V-ASSISTANT runs on the following operating systems: 

● Windows XP SP3 (Home) 

● Windows XP SP3 (Professional) 

● Windows 7 32 bit (Home Premium) 

● Windows 7 32 bit (Professional) 

● Windows 7 32 bit (Ultimate) 

● Windows 7 64 bit (Home Premium) 

● Windows 7 64 bit (Professional) 

● Windows 7 64 bit (Ultimate) 

 

 Note 

The minimum screen resolution must be 1024*768. 
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2.2 Device combination 
The table below shows the combination of SINAMICS V90 servo drives and SIMOTICS S-
1FL6 servo motors.  

 
SIMOTICS S-1FL6 servo motor SINAMICS V90 servo drive 
Rated 
torque 
(Nm) 

Rated 
power 
(kW) 

Rated 
speed 
(rpm) 

Shaft 
height 
(mm) 

Motor ID Order number1) Order number Frame 
size Without 

brake 
With 
brake 

1.27 0.4 3000 45 18 19 1FL6042-1AF61-0A❑1 6SL3210-5FE10-
4UA0 

FSAA 
10009 10038 1FL6042-1AF61-0L❑1 

2.39 0.75 3000 45 20 21 1FL6044-1AF61-0A❑1 6SL3210-5FE10-
8UA0 

 
FSA 10010 10039 1FL6044-1AF61-0L❑1 

3.58 0.75 2000 65 22 23 1FL6061-1AC61-0A❑1  
6SL3210-5FE11-
0UA0 

10011 10040 1FL6061-1AC61-0L❑1 
4.78 1.0 2000 65 24 25 1FL6062-1AC61-0A❑1 

10012 10041 1FL6062-1AC61-0L❑1 
7.16 1.5 2000 65 26 27 1FL6064-1AC61-0A❑1  

6SL3210-5FE11-
5UA0 

 
 
FSB 

10013 10042 1FL6064-1AC61-0L❑1 
8.36 1.75 2000 65 28 29 1FL6066-1AC61-0A❑1 

10014 10043 1FL6066-1AC61-0L❑1 
9.55 2.0 2000 65 30 31 1FL6067-1AC61-0A❑1 6SL3210-5FE12-

0UA0 10015 10044 1FL6067-1AC61-0L❑1 
11.9 2.5 2000 90 32 33 1FL6090-1AC61-0A❑1 

10016 10045 1FL6090-1AC61-0L❑1 
16.7 3.5 2000 90 34 35 1FL6092-1AC61-0A❑1 6SL3210-5FE13-

5UA0 
 
FSC 10017 10046 1FL6092-1AC61-0L❑1 

23.9 5.0 2000 90 36 37 1FL6094-1AC61-0A❑1 6SL3210-5FE15-
0UA0 10018 10047 1FL6094-1AC61-0L❑1 

33.4 7.0 2000 90 38 39 1FL6096-1AC61-0A❑1 6SL3210-5FE17-
0UA0 10019 10048 1FL6096-1AC61-0L❑1 

1) The symbol ❑ in the motor order numbers is for optional configurations (mechanics). For 
detailed motor rating plate explanation, refer to SINAMICS V90, SIMOTICS S-1FL6 
Operating Instructions. 
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 User interface 3 
3.1 Working modes 

When you start the SINAMICS V-ASSISTANT, the following window appears for you to 
select a working mode: 

 
The functions of SINAMICS V-ASSISTANT vary with the working modes. 

● Online mode: SINAMICS V-ASSISTANT communicates with the target drive, which is 
connected with PC by a USB cable. 

Select the online mode, a list of all the connected drives is displayed. Select the target 
drive and click the following button.  

 
SINAMICS V-ASSISTANT automatically creates a new project to save all the parameter 
settings from the target drive and enters the main window. 

 
  Note 

If SINAMICS V-ASSISTANT fails to detect the connected drive immediately, please wait 
for a while and then plug in the USB cable again. 
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● Offline mode: SINAMICS V-ASSISTANT does not communicate with any connected drive. 

Two options are available for your choice:  

 
– If you select the first option, you must select a drive from the following window: 

 
Select the line supply and firmware version from the drop-down lists respectively. Select 
the order number of a drive. Click  to save the factory settings of the selected 
drive to the new project and enter the main window; or otherwise, click  to 
cancel.  

 
  Note 

To obtain the firmware version, you can view r29018 on BOP (Basic Operator Panel). For 
more information, refer to SINAMICS V90, SIMOTICS S-1FL6 Operating Instructions. 
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– If you select the second option, you need to select an existing project in the following 
directory as the current project and enter the main window: 

 
 

① The default location is: xxx/Siemens/V-ASSISTANT/Project. 
xxx: SINAMICS V-ASSISTANT setup root directory. 

② Only .prj format is available. 

Status indicators 
In the SINAMICS V-ASSISTANT main window, the current working mode is indicated by the 
status indicators at the upper right of the main window: 
 

 
Online 

 
Offline 

You can switch the working mode between the two modes. For more information, refer to 
Section "Switch menu (Page 24)". 
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Compare parameters 
When you switch the working mode from offline to online, the following question will appear 
to remind you to save the current project: 

 
You can click  to save the project; or otherwise, you can click  or 

 to give up saving. 

Then SINAMICS V-ASSISTANT automatically compares all parameter settings between the 
current project and the connected drive: 
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If any inconsistency is detected, the following window will appear: 

 
Click the first button to upload all parameter values of the connected drive to the current 
project; or otherwise, click the second button to upload all parameter values of the current 
project to the connected drive. 
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3.2 User interface - overview 

 
① Menu bar 
② Toolbar 
③ Task navigation 
④ Function mask 
⑤ Alarm window 

Menu bar 
The menu bar is located at the top of the SINAMICS V-ASSISTANT window. You can find 
various commands and functions for basic operations of SINAMICS V-ASSISTANT. For 
more information, see Section "Menu bar (Page 19)". 

Toolbar 
The toolbar is located below the menu bar and provides direct access to the essential 
functions of SINAMICS V-ASSISTANT. For more information, see Section "Toolbar 
(Page 29)". 



 User interface 
 3.3 Menu bar 

SINAMICS V-ASSISTANT Online Help 
Operating Manual, 07/2015, A5E32187373-004 19 

Task navigation 
Task navigation lists the user tasks for users to fulfill. Each task contains different functions 
which facilitate users to parameterize all functions of V90 drives and monitor or diagnose the 
drives. For more information, see Section "Task navigation (Page 31)". 

Function mask 
The function mask provides the user interface of each user task for users to implement 
related functions. 

Alarm window 
In online mode, the current faults and alarms are displayed in a list with the corresponding 
type, number and name. In offline mode, the alarm window is disabled. For more information, 
see Section "Alarm window (Page 30)". 

3.3 Menu bar 

3.3.1 Menu bar - overview 
The menu bar lists the menu items for users to manage the projects, switch the interface 
language, or view the online help: 

Project menu (Page 19)  

Edit menu (Page 23) 

Switch menu (Page 24) 

Tools menu (Page 25) 

Help menu (Page 28)  

3.3.2 Project menu 
This menu contains commands for creating, opening, saving, printing,or exiting from a 
project as well as switching the interface language. You can choose any menu command 
here for project management. 

● New project (Page 20) 

● Open project (Page 20) 

● Save project (Page 21) 

● Save project as (Page 22) 

● Print (Page 22) 
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● Language (Page 23) 

● Exit (Page 23) 

3.3.2.1 Project -> New project 
When SINAMICS V-ASSISTANT is working in offline mode, you can use this menu 
command to create a new project. To proceed, refer to Selecting drive (Page 34). 

3.3.2.2 Project -> Open project 
When SINAMICS V-ASSISTANT is working in offline mode, you can use this menu 
command to open an existing project in the following window: 

 
 

① The default location is: xxx/Siemens/V-ASSISTANT/Project. 
xxx: SINAMICS V-ASSISTANT setup root directory. 

② Only .prj format is available. 
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3.3.2.3 Project -> Save project 

Online mode/offline mode 
You can use this menu command to save the changed configuration to the current project. If 
this menu command is used for the first time, it is the same as "Project -> Save project as... 
(Page 22)". You can specify the file name and directory in the following window: 

 
 

① The default location is: xxx/Siemens/V-ASSISTANT/Project. 
 xxx: SINAMICS V-ASSISTANT setup root directory. 

② Only .prj format is available. 
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3.3.2.4 Project -> Save project as... 

Online mode/offline mode 
You can use this menu command to save the current project with a specified file name and 
directory in the following window: 

 
 

① The default location is: xxx/Siemens/V-ASSISTANT/Project. 
 xxx: SINAMICS V-ASSISTANT setup root directory. 

② Only .prj format is available. 

3.3.2.5 Project -> Print 

Online mode/offline mode 
You can use this menu command to print the user interface of the selected function from 
"Task navigation (Page 31)". 
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3.3.2.6 Project -> Language 

Online mode/offline mode 
You can use this menu command to switch the interface language among the following 
languages including English, Chinese, German, French, Italian, Trukish, Spanish and 
Portuguese. 

3.3.2.7 Project -> Exit 

Online mode/offline mode 
You can use this menu command to exit from the SINAMICS V-ASSISTANT directly. 

3.3.3 Edit menu 
This menu contains commands for cutting, copying and editing the parameter values or 
technical data related to the motor and drive. 

● Cut (Page 23) 

● Copy (Page 24) 

● Paste (Page 24) 

3.3.3.1 Edit -> Cut 
The command deletes the selected objects, for example, the parameter values from the user 
interface, and copies them to the clipboard. 

Alternatively, you can use  from the toolbar. 
 

 Note 

This menu command can only be used to modify the values in "Viewing all parameters 
(Page 65)". 
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3.3.3.2 Edit -> Copy 
The command is used to copy selected objects, for example, parameter values, order 
number or the rated power of the drive or motor, to the clipboard. 

Alternatively, you can use  from the toolbar. 
 

 Note 

You can only use this menu command on the following function masks: 
• Selecting drive (Page 34) 
• Selecting motor (Page 36) 
• Viewing all parameters (Page 65) 
• Signal (Page 67) 

3.3.3.3 Edit -> Paste 
This menu command copies the clipboard content to the input field. The copied content will 
be inserted in a position determined with a mouse click. 

Alternatively, you can use  from the toolbar. 
 

 Note 

You can only use this menu command to modify the values in Viewing all parameters 
(Page 65). 

3.3.4 Switch menu 
This menu contains the following two commands to switch the SINAMICS V-ASSISTANT 
between online mode and offline mode. 

●  Go offline  (Page 24) 

 

●  Go online (Page 24) 

3.3.4.1 Switch -> Go offline 
When SINAMICS V-ASSISTANT is working in online mode, you can use this menu 
command to switch to offline mode. 

Alternatively, you can use  from the toolbar. 

3.3.4.2 Switch -> Go online 
When SINAMICS V-ASSISTANT is working in offline mode, you can use this menu 
command to switch to online mode. 

Alternatively, you can use  from the toolbar. 
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3.3.5 Tools menu 
The tools menu contains the following menu commands: 

● Tools -> Save parameters to ROM (Page 25) 

● Tools -> Restart drive (Page 25) 

● Tools -> Reset absolute encoder (Page 26) 

● Tools -> Factory default (Page 26) 

● Tools -> Upload parameters (Page 28) 

3.3.5.1 Tools -> Save parameters to ROM 
You can use this menu command to save the parameters from RAM to ROM in the drive. 
The following window will appear to display the saving process: 

 
Alternatively, you can use  from the toolbar. 

3.3.5.2 Tools -> Restart drive 
You can use this menu command to restart the drive. The following reminder will appear: 
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If you click , then the following information will appear: 

 
Click  and the drive is reset successfully. 

3.3.5.3 Tools -> Reset absolute encoder 
In online mode, if SINAMICS V-ASSISTANT is connected with an absolute encoder, you can 
use this menu command to set the current position of the absolute encoder as the reference 
point. 

3.3.5.4 Tools -> Factory default 

Online 
Select this menu command and the following reminder will appear: 
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● If you click , then the following information window will appear: 

 
When the process is finished, the window disappears automatically. 

● If you click  or , the operation will be aborted. 

Offline 
Select this menu command and the following reminder will appear: 

 
● If you click , after the parameters are reset to their factory defaults, the 

following information will appear: 

 
Click  to close the information window. To save the project, please refer to 
Section "Project -> Save project (Page 21)". 

● If you click  or , the operation is aborted. 
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3.3.5.5 Tools -> Upload parameters 
 

 Note 

This menu command is only available in online mode. 
 

You can use the menu command to upload parameters from the drive to SINAMICS V-
ASSISTANT. The following window will appear to show the process: 

 
After the process is complete, the values of the same parameters in SINAMICS V-
ASSISTANT will be replaced by those in the drive automatically. 

3.3.6 Help menu 
The Online help quickly provides you with information about drive selection, parameterization, 
commissioning and diagnostics of SINAMICS V-ASSISTANT. 

● Help -> View help (Page 28) 

● Help -> About SINAMICS V-ASSISTANT... (Page 29) 

3.3.6.1 Help -> View help 
You can use this menu command to display the content of SINAMICS V-ASSISTANT Online 
help. 



 User interface 
 3.4 Toolbar 

SINAMICS V-ASSISTANT Online Help 
Operating Manual, 07/2015, A5E32187373-004 29 

3.3.6.2 Help -> About SINAMICS V-ASSISTANT... 
You can use this menu command to display the following information window for SINAMICS 
V-ASSISTANT. 

 

3.4 Toolbar 
The icons of the toolbar provide quick access to the commands in the menu bar or functions 
from Task navigation (Page 31). 

 
 

 
New project (Page 20) 

 
Open project (Page 20)  

 
Save project (Page 21)  

 
Print (Page 22)  

 
Cut (Page 23) 

 
Copy (Page 24) 

 
Paste (Page 24) 

 Go offline (Page 24)  

 Go online (Page 24) 

 Save parameters to ROM (Page 25) 
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Upload parameters (Page 28) 

 
Viewing all parameters (Page 65) 

 
Trace (Page 96)  

 
Test motor (Page 79) 

 
Help (Page 28) 

3.5 Alarm window 

Alarm window overview 

 
 

① Alarm type: 
 : Fault 
 : Alarm 

Faults have priority over alarms in display. 

③ Alarm name and description 

② Alarm number ④ Acknowledge All: 
Clears the faults in the buffer area of the 
drive 

3.6 Function keys and shortcuts 
For frequently called functions, corresponding function keys and shortcuts are provided. 

Function keys in SINAMICS V-ASSISTANT 
 
[F1] → Calls the context sensitive Online help 
[Ctrl+X] → Edit -> Cut (Page 23) 
[Ctrl+C] → Edit -> Copy (Page 24) 
[Ctrl+V] → Edit -> Paste (Page 24) 
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 Task navigation 4 
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Task Sub-functions 
Selecting drive 
(Page 33) 

• Selecting drive (Page 34) 
• Selecting motor (Page 36) 
• Control mode (Page 37) 
• Jog (Page 39) 

Parameterizing 
(Page 41) 

• Setting electronic gear ratio (Page 42) 
• Setting mechanism (Page 45) 
• Setting parameter setpoint (Page 46) 
• Setting limits (Page 53) 
• Configuring inputs/outputs (Page 56) 
• Configuring referencing (Page 58) 
• Setting encoder pulse output (Page 63) 
• Backlash compensation (Page 64) 
• Viewing all parameters (Page 65) 

Commissioning 
(Page 67) 

• Testing interface (Page 67) 
• Testing motor (Page 79) 
• Optimizing drive (Page 82) 

Diagnostics 
(Page 95) 

• Monitoring status (Page 95) 
• Tracing signals (Page 96) 
• Measuring machine (Page 101) 
 

 



 Task navigation 
 

SINAMICS V-ASSISTANT Online Help 
Operating Manual, 07/2015, A5E32187373-004 33 

4.1 Selecting drive 

 
 

① Drive selection Select a drive in this field. 
For more information, refer to Section "Selecting drive 
(Page 34)". 

② Motor selection Select a motor in this field. 
For more information, refer to Section "Selecting motor 
(Page 36)". 

③ Control mode Select a control mode in this field. 
For more information, refer to Section "Control mode (Page 37)". 

④ Jog Test the Jog function in this field. 
For more information, refer to Section "Jog (Page 39). 
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4.1.1 Selecting drive 

Online mode 
When you choose to work in online mode, a list of connected drive type(s) is displayed for 
your selection: 

 
Select the target drive type, and click  to establish communication between the 
SINAMICS V-ASSISTANT and the drive. SINAMICS V-ASSISTANT reads all parameter 
settings from the connected drive and the main window displays the drive information on the 
following panel: 

 
The following drive information is displayed: 

● Order number 

● Line supply 
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● Rated power 

● Rated current 

 
  Note 

 is disabled in online mode. 
 

Offline mode 
When you are working in offline mode, the SINAMICS V-ASSISTANT does not communicate 
with the connected drive (s). 

You can click  to change the drive type in the following window: 

 
Select the order number of the target drive. Click  to save the factory settings of 
the selected drive to the new project and enter the main window; or otherwise, click 

 to cancel.  
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4.1.2 Selecting motor 

Online mode 

● If the connected motor is equipped with an absolute encoder,  is disabled. 

 
 

  Note 

In the order number, "x" is a wildcard; for more information about "A\G", please refer to 
SINAMICS V90, SIMOTICS S-1FL6 Operating Instructions. 

 

● If the connected motor is equipped with an incremental encoder, click  
and the motor list is displayed. 

 
Select a motor from the list and click the following button to confirm your selection: 
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  Note 

You can click "name plate" in the above window to see the specific location of the name 
plate on the motor. 

 

Offline mode 
● If you choose to create a new project, you need to select a drive first, then the information 

of the default motor is displayed. 

● If you choose to open an existing project, the saved motor information is displayed. 

● If you switch from online mode to offline mode, you can select the motor by clicking 
. 

4.1.3 Control mode 

Online mode/offline mode 

 
Totally, nine control modes are available: 
 
Control modes Abbreviation 
Basic control modes Pulse train input position control mode (PTI) 1) PTI 

Internal position control mode (IPos) IPos 
Speed control mode (S) S 
Torque control mode (T) T 

Compound control 
modes 

Control change mode: PTI/S PTI/S 
Control change mode: IPos/S IPos/S 
Control change mode: PTI/T PTI/T 
Control change mode: IPos/T IPos/T 
Control change mode: S/T S/T 

 1) Default control mode 
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Apply a control mode 
After you select a control mode, a warning message appears: 

 
Click  and the following message appears: 

 
Click  to save all the parameters to ROM and reset the drive.  

Otherwise, click the following button or directly close the dialog box, and the drive will work in 
the current control mode. 

 



 Task navigation 
 

SINAMICS V-ASSISTANT Online Help 
Operating Manual, 07/2015, A5E32187373-004 39 

4.1.4 Jog 
Jog function is only available in online mode. You can configure this function on the following 
panel: 

 
● To start the Jog function, you can enter the Jog speed. Click , 

then the following warning will appear: 

 
Click  and run the drive counter-clockwisely/clockwisely by clicking the 
following two buttons respectively: 

 

  

Then the actual speed, actual torque, actual current and actual utilization will be 
displayed. 
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●  To stop the Jog function, you can click  in the following window 
and the SINAMICS V-ASSISTANT will release the control priority. 

 
 

 Note 

The Jog speed should not be too fast. Otherwise, the machine axes will get out of control 
due to possible communication delay. 
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4.2 Parameterizing 

 
Totally, there are nine functions. The sub-function combinations vary with the control modes: 
 
Function Control mode 

PTI IPos S T 
Setting electronic gear ratio (Page 42) ✓    
Setting mechanism (Page 45)  ✓   
Setting parameter setpoint (Page 46) ✓ ✓ ✓ ✓ 
Setting limits (Page 53) ✓ ✓ ✓ ✓ 
Configuring inputs/outputs (Page 56) ✓ ✓ ✓ ✓ 
Configuring referencing (Page 58)  ✓   
Setting encoder pulse output (Page 63) ✓ ✓   
Backlash compensation (Page 64)  ✓   
Viewing all parameters (Page 65) ✓ ✓ ✓ ✓ 
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4.2.1 Setting electronic gear ratio 

4.2.1.1 Overview 
Setting electronic gear ratio is only available in pulse train input position control mode (PTI). 

Select one of the following options for setting electronic gear ratio: 

 
 
Op-
tions 

Description 

① When number of setpoint pulses per motor revolution (p29011) is 0, configure electronic 
gear ratio by setting numerator (p29012) and denominator (p29013). 

② When number of setpoint pulses per motor revolution is not 0, enter the number of setpoint 
pulses per motor revolution here. 

③ Calculate the electronic gear ratio according to different mechanical structures.  
Totally, five mechanical structures are available: 
1. Ball screw 
2. Disc table 
3. Belt pulley 
4. Rack and pinion 
5. Roll feed 
For more information, refer to "Mechanical structure (Page 43)". 
You need to input the pitch value and gear ratio. Select a display unit and click 

. Then the electronic gear ratio will be worked out. 
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4.2.1.2 Mechanical structure 

Variables 
Configure variables according to the selected mechanical structure: 
 
Mechanical 
structure 

Graphical view Variable settings 
Variable Range 

Ball screw 

 

P: Pitch value (mm) 0.0001 to 
2147000000 

N: Load revolutions 1 to 2147000000 
M: Motor revolutions 1 to 2147000000 

Disc table 

 

N: Load revolutions 1 to 2147000000 
M: Motor revolutions 1 to 2147000000 

Belt pulley 

 

D: Diameter (mm) 
 

0.0001 to 
2147000000 

N: Load revolutions 1 to 2147000000 
M: Motor revolutions 1 to 2147000000 

Rack and 
pinion 

 

D: Diameter (mm) 
 

0.0001 to 
2147000000 

N: Load revolutions 1 to 2147000000 
M: Motor revolutions 1 to 2147000000 

Roll feed 

 

D: Diameter (mm) 
 

0.0001 to 
2147000000 

N: Load revolutions 1 to 2147000000 
M: Motor revolutions 1 to 2147000000 
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Unit 
After configuring the variables for the selected mechanical structure, you must select one of 
the following units and input values within the scope: 

● Length unit 

Range: 0.0001 to 2147000000 

● Axis movement per load revolution 

Range: 1 to 2147000000 

Calculation 
Click  to calculate the electronic gear ratio and the calculated result is displayed 
as the following example: 

 
 

 Note 

If either the numerator or the denominator of the electronic gear ratio is larger than 10000, 
the ratio will be reduced automatically to make them smaller than 10000. 
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4.2.2 Setting mechanism 
By parameterizing the mechanical system, the link between the physical moving part and the 
length unit (LU) is established. Select the mechanical structure. Set the gearbox factor and 
the length unit per revolution of the load on the following panel: 

 
The unit of the fixed position setpoint is the Length Unit (LU). All subsequent position 
setpoint, related speed value, and acceleration value will maintain the LU as the unit in 
internal position control mode.  

Taking a ball screw system for example, if the system has a pitch of 10 mm/revolution, the 
resolution of the length unit should be 1 µm (1 LU = 1 µm). Therefore, one load revolution 
corresponds to 10000 LU (p29247 = 10000). 
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4.2.3 Setting parameter setpoint 
Setting parameter setpoint is used to specify parameters related to speed, torque and 
position.  

Depending on the current control mode, you can configure parameters of the sub-functions 
as follows: 
 
Function Control mode 

PTI IPos S T 
Signal form selection 
(Page 50) 

✓    

Position setpoint smoothing 
time setting (Page 50) 

✓ ✓   

Position reached window 
setting (Page 50) 

✓ ✓   

Fixed position setpoint 
(Page 50) 

 ✓   

Speed setpoint (Page 47)   ✓  
Ramp-function generator 
(Page 47) 

  ✓  

Speed reached window 
(Page 47) 

  ✓  

Torque setpoint (Page 46)    ✓ 

In compound control modes, setting parameter setpoint can be referred to the single control 
mode. 

4.2.3.1 Torque setpoint 
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Source of torque setpoint 
Two sources are available for torque setpoint: 

● External setpoint: analog input 2 

● Fixed setpoint: p29043 

 These two resources can be selected with the digital input signal TSET: 
 
Signal Level Source of torque setpoint 
TSET 0 (default) Analog torque setpoint (analog input 2) 

1 Fixed torque setpoint (p29043) 

4.2.3.2 Speed setpoint 

 

Source of speed setpoint 
Eight sources in total are available for speed setpoint. You can select one of them with the 
combination of digital input signals SPD1, SPD2 and SPD3: 
 
Digital signal Torque limit 
SPD3 SPD2 SPD1 
0 0 0 External analog speed setpoint (analog input 1) 
0 0 1 Fixed speed setpoint 1 (p1001) 
0 1 0 Fixed speed setpoint 2 (p1002) 
0 1 1 Fixed speed setpoint 3 (p1003) 
1 0 0 Fixed speed setpoint 4 (p1004) 
1 0 1 Fixed speed setpoint 5 (p1005) 
1 1 0 Fixed speed setpoint 6 (p1006) 
1 1 1 Fixed speed setpoint 7 (p1007) 
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Ramp-function generator 
The ramp-function generator is used to limit acceleration in the event of abrupt setpoint 
changes and thus helps prevent load surges during drive operation. 

The ramp-up time p1120 and ramp-down time p1121 can be used to set acceleration and 
deceleration ramps separately. This allows a smoothed transition in the event of setpoint 
changes. 

Two types of ramp-function generator are available. You can specify the parameters on the 
corresponding panels: 

● Basic ramp-function generator 

 
● Extended ramp-function generator 
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Speed reached window 
Set parameter p29078 for controller to decide whether the setpoint speed is reached on the 
following panel: 
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4.2.3.3 Position setpoint 

Position setpoint 
● In pulse train input position control mode, you can select one signal to link with pulse train 

input from the following options: 

 
Select the signal level on the following panel: 

 
For detailed information, refer to the Section "Pulse train inputs (PTIs) (Page 79)". 

● In internal position control mode, you must specify position setpoint on the following panel: 

 
Linear axis or modular axis can be used depending on your actual application. 

– The linear axis has a restricted traversing range and it is the factory setting of the 
SINAMICS V90 servo drive. 

– The modular axis has an unrestricted traversing range. 

You can directly enter the digital value in the cells for the following items: 

– Position 

– Speed 
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– Acceleration 

– Deceleration 

The current active position setpoint channel is displayed at the bottom of this panel. The 
channels correspond with p2617 and p2618 as follows: 
Position setpoint channel Index of p2617 Index of p2618 
0 0 0 
1 1 1 
2 2 2 
3 3 3 
4 4 4 
5 5 5 
6 6 6 
7 7 7 

Source for internal position setpoint 

Eight position setpoints in total are available. Each position setpoint comes from one 
group of position data: 

Fixed position set-
point 

Corresponding parameters 
Parameter Description 

Fixed position set-
point 1 

p2617[0] Fixed position setpoint 1 (P_pos1) 
p2618[0] Speed of fixed position setpoint 1 (P_pos_spd1) 
p2572 IPos maximum acceleration 
p2573 IPos maximum deceleration 

Fixed position set-
point 2 

p2617[1] Fixed position setpoint 2 (P_pos2) 
p2618[1] Speed of fixed position setpoint 2 (P_pos_spd2) 
p2572 IPos maximum acceleration 
p2573 IPos maximum deceleration 

Fixed position set-
point 3 

p2617[2] Fixed position setpoint 3 (P_pos3) 
p2618[2] Speed of fixed position setpoint 3 (P_pos_spd3) 
p2572 IPos maximum acceleration 
p2573 IPos maximum deceleration 

Fixed position set-
point 4 

p2617[3] Fixed position setpoint 4 (P_pos4) 
p2618[3] Speed of fixed position setpoint 4 (P_pos_spd4) 
p2572 IPos maximum acceleration 
p2573 IPos maximum deceleration 

Fixed position set-
point 5 

p2617[4] Fixed position setpoint 5 (P_pos5) 
p2618[4] Speed of fixed position setpoint 5 (P_pos_spd5) 
p2572 IPos maximum acceleration 
p2573 IPos maximum deceleration 

Fixed position set-
point 6 

p2617[5] Fixed position setpoint 6 (P_pos6) 
p2618[5] Speed of fixed position setpoint 6 (P_pos_spd6) 
p2572 IPos maximum acceleration 
p2573 IPos maximum deceleration 
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Fixed position set-
point 

Corresponding parameters 
Parameter Description 

Fixed position set-
point 7 

p2617[6] Fixed position setpoint 7 (P_pos7) 
p2618[6] Speed of fixed position setpoint 7 (P_pos_spd7) 
p2572 IPos maximum acceleration 
p2573 IPos maximum deceleration 

Fixed position set-
point 8 

p2617[7] Fixed position setpoint 8 (P_pos8) 
p2618[7] Speed of fixed position setpoint 8 (P_pos_spd8) 
p2572 IPos maximum acceleration 
p2573 IPos maximum deceleration 

Position setpoint smoothing time setting 
With the smoothing function, the position characteristics curve from the pulse train input 
setpoint can be transformed into an S-curve profile with a time constant specified in p2533.  
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Position reached window setting 
Set parameter p2544 to specify the monitoring window for controller to decide whether the 
setpoint position is reached on the following panel: 

 
Refer to Section "Digital outputs (DOs) (Page 75)" for more information about signal INP. 

4.2.4 Setting limits 
You can configure speed limit, torque limit and software position limit with this function. The 
sub-functions vary with the selected control mode as follows: 
 
Functions Control Mode 

PTI IPos S T 
Torque limit (Page 54) ✓ ✓ ✓  
Overall torque limit ✓ ✓ ✓ ✓ 
Speed limit (Page 55) ✓ ✓ ✓ ✓ 
Overall speed limit ✓ ✓ ✓ ✓ 
Software Position limit 
(Page 62) 

 ✓   
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4.2.4.1 Torque limit 
Torque limit is available in control modes PTI, IPos and S. 

You can specify the corresponding parameters on the following panel: 

 

Source of torque limit 
Four sources in total are available for torque limit. You can select one of them via a 
combination of digital input signals TLIM1 and TLIM2: 
 
Digital signal Torque limit 
TLIM2 TLIM1 
0 0 Internal torque limit 1 
0 1 External torque limit (analog input 2) 
1 0 Internal torque limit 2 
1 1 Internal torque limit 3 

When the torque setpoint reaches torque limit, the torque is limited to the value selected by 
TLIM1/TLIM2. 

 

 Note 
Control mode 

These four sources are valid in the PTI mode, the IPos mode and the S mode. You can 
switch among them when the servo drive is running. 

 

Refer to Section "Digital inputs (DIs) (Page 70)" for more information about the digital input 
signals TLIM1 and TLIM2. 

Overall torque limit 
Besides the above four sources, an overall torque limit is available for all control modes. The 
overall torque limit takes effect when an emergency stop (OFF3) happens. In this case, the 
servo drive brakes with a maximum torque. 
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4.2.4.2 Speed limit 
You can specify the corresponding parameters on the following panel: 

 

Source of speed Limit 
Four sources in total are available for speed limit. You can select one of them via a 
combination of digital input signals SLIM1 and SLIM2: 
 
Digital signal Speed limit 
SLIM2 SLIM1 
0 0 Internal speed limit 1 
0 1 External speed limit (analog input 1) 
1 0 Internal speed limit 2 
1 1 Internal speed limit 3 

 

 

 Note 
Control mode 

The above four sources are valid in all control modes. You can switch among them when the 
servo drive is running. 

 

When the speed setpoint reaches the speed limit, an alarm occurs. 

Refer to Section "Digital inputs (DIs) (Page 70)" for more information about the digital input 
signals SLIM1 and SLIM2.  

Overall speed limit 
Besides the above four channels, an overall speed limit is available for all control modes. 
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4.2.5 Configuring inputs/outputs 
Three sub-functions are available as follows: 

● Assigning digital inputs (Page 56) 

● Assigning digital outputs (Page 57) 

● Assigning analog outputs (Page 57) 

4.2.5.1 Assigning digital inputs 
You can assign digital inputs on the following panel: 

 
28 signals in total can be freely linked to digital inputs except for DI9 and DI10 linked with 
E_Stop and C_Mode signals, for more information, refer to Section "Digital inputs (DIs) 
(Page 70)". 

Click the cells with white background in the table. Two options are displayed in the drop-
down list: Assign and Cancel. Select "Assign" to link the digital input with the corresponding 
signal. Then the current row displays grey. Otherwise, select "Cancel" to release the link. 
The current row will then display white. 

You can activate the checkbox in column "Set to 1" to forcely set the signal status to 1. For 
the signal EMGS, it can be forcely set to 1 when the drive firmware version is V1.04 and 
higher.  

 

 Note 

Signal P_TRG in PTI mode is reserved for future use. 
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4.2.5.2 Assigning digital outputs 
You can assign digital outputs on the following panel: 

 
12 signals in total can be freely linked to digital outputs. For more information, refer to Digital 
outputs (DOs) (Page 75).  

Click the cells with white background in the table. Select "Assign" to link the digital input with 
the corresponding signal. Then the current cell displays grey. 

4.2.5.3 Assigning analog outputs 
You can assign analog outputs on the panel below: 
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Seven signals in total can be linked with either analog output. For more information, refer to 
Section "Analog outputs (AOs) (Page 78)".  

By default, analog output 1and analog output 2 are linked with actual speed and actual 
torque respectively. You can freely select the target signal in the drop-down list to link with 
analog outputs. 

4.2.6 Configuring referencing 
Referencing is only available in internal position control mode (IPos). 

Two functions are available under referencing: 

● Setting referencing (Page 58) 

● Setting software position limit (Page 62) 

4.2.6.1 Setting referencing 
Setting referencing is only available in online mode. 

● Absolute encoder 

If the motor is equipped with an absolute encoder, click  on the folllowing 
panel to configure referencing: 
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● Incremental encoder 

If the motor is equipped with an incremental encoder, five referencing modes in total are 
available: 

 

Parame-
ter 

Val-
ue 

Referencing mode Illustration 

p29240 0 Setting the reference 
point via digital input 
(signal REF) 

 

1 External reference 
cam (signal REF) 
and encoder zero 
mark 
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Parame-
ter 

Val-
ue 

Referencing mode Illustration 

2 Encoder zero mark 
only 

 

3 External reference 
cam (CCWL signal) 
and encoder zero 
mark 

 

4 External reference 
cam (CWL signal) 
and encoder zero 
mark 
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Taking the second referencing mode as an example, you can configure relevant 
parameters on the following panel: 

 
Assign signals REF and SREF(for more information, refer to "Configuring inputs/outputs 
(Page 56)"). Click  and the following warning appears: 

 
Click  to start referencing and the following window appears: 

 
Click the button below to stop the referencing process. 
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4.2.6.2 Setting software position limit 
The following two software position limits are available in the internal position control mode 
(IPos): 

● positive position limit 

● negative position limit 

 

 Note 

The function of software position limit only becomes active after referencing. When the 
actual position reaches one of the above-mentioned software position limits, motor speed 
decelerates to 0. 

 

You can set the software position limit on the following panel: 

 
Method 1: Setting through manual input 

Click the check box to enable the software position limit. Enter the desired position values in 
the bottom input fields directly. 

Method 2: Setting through the Jog function 
 
 1. Click the checkbox to enable the software position limit. 
 2. Enter the speed value. 

Note: 
The Jog speed should not be too fast. Otherwise, the machine 
axes will get out of control due to possible communication 
delay. 

 3. Click this button to execute servo-on and a warning message 
will appear. Confirm your selection by clicking  in the 
message window. 

 
4. Click this button to rotate the motor clockwisely and the motor 

will reach the maximum position. 
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 5. Obtain the current position by clicking this button. 

 
6. Click this button to rotate the motor counter-clockwisely and 

the motor will reach the minimum position. 

 7. Obtain the current position by clicking this button. 

 8. If you desire to disable this function, you can click this button 
and the checkbox. 

 

 

 Note 

Prerequisites for setting the software position limit: 
• Referencing is completed successfully 
• Linear axis working mode is selected 

 

4.2.7 Setting encoder pulse output 
When SINAMICS V-ASSISTANT is working in position control modes (PTI and IPos), you 
can configure pulse output on the following panel: 

 
SINAMICS V-ASSISTANT automatically identifies the encoder type and resolution. 

Two options are listed for you to configure relevant parameters: 

● Set PTO number per revolution 

● Set PTO number by gear ratio 
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4.2.8 Backlash compensation 
Generally, backlash occurs when the mechanical force is transferred between a machine 
part and its drive. 

If the mechanical system was to be adjusted/designed so that there was absolutely no 
backlash, this would result in high wear. Thus, backlash can occur between the machine 
component and the encoder. For axes with indirect position sensing, mechanical backlash 
results in a false traversing distance because the axis, at direction reversal, travels either too 
far or not far enough corresponding to the absolute value of the backlash. 

You can configure backlash compensation on the following panel: 

 
In order to compensate the backlash, the determined backlash must be specified in p2583 
with correct polarity. At each direction of rotation reversal, the axis actual value is corrected 
dependent on the actual traversing direction. 

 

 Note 
Pre-conditions for backlash compensation 

The backlash compensation is active after 
• the axis has been referenced for incremental measuring system. Refer to Section "Setting 

referencing (Page 58)" for detailed information about referencing. 
• the axis has been adjusted for absolute measuring system. 
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4.2.9 Viewing all parameters 
You can configure all editable parameters in this field: 

 
 

 Note 

The parameter with an icon in the table means that the parameter is used by Modbus 
communication function. You can click on the icon to see the detailed information about the 
communication function. 

 

 

Field Description 
Group filter Views parameters according to different groups. 
Find Filters the parameter list according to the entered text. The filtering is done after you 

enter the desired text. 
Factory 
default 

You can click the following button to reset all parameters to their factory settings: 

 
For more information, refer to Section "Tools -> Factory default (Page 26)". 
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Field Description 
Save 
changes 

You can click the following button to save the changes compared to the de-
faults/factory settings into an .html file which can be further used for documentation 
purposes or as an reference for BOP commisioning. 

 
Save in the following window: 

 

①: The default location is: xxx/Siemens/V-ASSISTANT/Project. 
 xxx: SINAMICS V-ASSISTANT setup root directory 

②: Only .html format is available. 
Table All parameters are displayed with the following information: 

• Group 
• Parameter number 
• Name 
• Value 
• Unit 
• Range 
• Factory setting 
• Effect type 
Note: 
In the value related column, values with white background are editable. 
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4.3 Commissioning 

4.3.1 Testing interface 

4.3.1.1 I/O simulation 
When SINAMICS V-ASSISTANT is working in online mode, you can view the I/O status on 
the following panel:  
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Area Item Description 

① Pulse train input Information about pulse train input: 
• Received number of pulses. 
• Pulse frequency. 
For more information, refer to Section "Pulse train inputs 
(PTIs) (Page 79)". 

② DI1~DI8 Every digital input can be linked with either of the 28 
internal signals. 

DI9 Linked with EMGS signal. 
DI10 Linked with C_MODE signal. 
Note: 
For more information about the number and definition of signals, refer to Section"Digital inputs 
(DIs) (Page 70)". 

③ AI1 Linked with speed related signals. 
AI2 Linked with torque related signals. 
Note: 
For more information about analog inputs, refer to Section "Analog inputs (AIs) (Page 77)". 

④ AO1 Linked with actual speed signal by default. 
AO2 Linked with actual torque signal by default. 
Note: 
For more information, refer to Section "Analog outputs (AOs) (Page 78)". 

⑤ DO1~DO6 Every digital output can be freely linked with either of the 
12 internal signals. For more information, refer to Section 
"Digital outputs (DOs) (Page 75)". 

⑥  
Clicking this button enables DO simulation. If you desire 
to disable this function, click the following button: 

 

⑦  

 

Signal is enabled Indicates high-voltage (or logic 1) is on the digital in-
put/output. 

 

 

Signal is disabled Indicates low-voltage (or logic 0) is on the digital in-
put/output. 

 

 

Signal is forcedly set 
to 1 

Indicates the status of the assigned signal is forcedly set 
to 1. 
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 Note 
• This function is unavailable but can be displayed in offline mode. 
• The status of each indicator and analog value are updated every 0.5 s. 
• Signal P_TRG in PTI mode is reserved for future use. 
• You can change the signal link as you desire. For more information, refer to Section 

"Configuring inputs/outputs (Page 56)". 
 

Status of DI signals 
You can view the name, description, value and status of individual DI signals on the following 
panel: 

 



Task navigation  
 

 SINAMICS V-ASSISTANT Online Help 
70 Operating Manual, 07/2015, A5E32187373-004 

4.3.1.2 Digital inputs (DIs) 
You can assign a maximum of 28 internal digital input signals to the SINAMICS V90 servo 
drive. For detailed information about these signals, see the table below: 
 
No. Name Type Description Control mode 

PTI IPos S T 
1 SON Edge 

0→1 
1→0 

Servo-on 
• 0→1: powers on power circuit and makes 

servo drive ready to operate. 
• 1→0: motor ramps down (OFF1) in PTI, 

IPos, and S modes; motor coasts down 
(OFF2) in T mode. 

✓ ✓ ✓ ✓ 

2 RESET Edge 
0→1 

Reset alarms 
• 0→1: Reset alarms 

✓ ✓ ✓ ✓ 

3 CWL Edge 
1→0 

Clockwise over-travel limit (positive limit) 
• 1 = condition for operation 
• 1→0: emergency stop (OFF3) 

✓ ✓ ✓ ✓ 

4 CCWL Edge 
1→0 

Counter-clockwise over-travel limit (negative 
limit). 
• 1 = condition for operation 
• 1→0: emergency stop (OFF3) 

✓ ✓ ✓ ✓ 

5 G-
CHANGE 

Level Gain change between the first and the sec-
ond gain parameter sets. 
• 0: the first gain parameter set 
• 1: the second gain parameter set 

✓ ✓ ✓ X 

6 P-TRG 
(P_TRG  
in PTI 
mode is 
reserved 
for future 
use) 

Level 
Edge 
0→1 

In PTI mode: pulse allowable/inhibit. 
• 0: operation with pulse train setpoint is 

possible 
• 1: inhibit the pulse train setpoint 
In IPos mode: position trigger 
• 0→1: starts positioning of selected fixed 

position setpoint 

✓ ✓ X X 

7 CLR Level Clear position control droop pulses. 
• 0: not clearing 
• 1: clear droop pulses based on the set-

ting of p29242 

✓ X X X 
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No. Name Type Description Control mode 
PTI IPos S T 

8 EGEAR1 Level Electronic gear. 
A combination of the signals EGEAR1 and 
EGEAR2 can select four electronic gear 
ratios. 
EGEAR2 : EGEAR1 
• 0 : 0: electronic gear ratios 1 
• 0 : 1: electronic gear ratios 2 
• 1 : 0: electronic gear ratios 3 
• 1 : 1: electronic gear ratios 4 

✓ ✓ X X 
9 EGEAR2 Level ✓ ✓ X X 

10 TLIM1 Level Torque limit selection. 
A combination of TLIM1 and TLIM2 can 
select four torque limit sources (one external 
torque limit, three internal torque limits). 
TLIM2 : TLIM1 
• 0 : 0: internal torque limit 1 
• 0 : 1: external torque limit (Analog Input 

2) 
• 1 : 0: internal torque limit 2 
• 1 : 1: internal torque limit 3 

✓ ✓ ✓ X 
11 TLIM2 Level 

12 CWE Level Enable clockwise rotations. 
• 1: Enable clockwise rotation, ramp up 
• 0: Disable clockwise rotation, ramp down 

X X ✓ ✓ 

13 CCWE Level Enable counter-clockwise rotations. 
• 1: Enable counter-clockwise rotation, 

ramp down 
• 0: Disable counter-clockwise rotation, 

ramp up 

X X ✓ ✓ 

14 ZSCLAM
P 

Level Zero speed clamps. 
• 1 = when the motor speed setpoint is an 

analog signal and lower than the thresh-
old level (p29075), the motor is clamped. 

• 0 = no action 

X X ✓ X 
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No. Name Type Description Control mode 
PTI IPos S T 

15 SPD1 Level Select speed mode: fixed speed setpoint. 
A combination of the signals SPD1, SPD2 
and SPD3 can select eight speed setpoint 
sources (one external speed setpoint, seven 
fixed speed setpoint). 
SPD3 : SPD2 : SPD1 
• 0 : 0 : 0: external analog speed setpoint 
• 0 : 0 : 1: fixed speed setpoint 1 
• 0 : 1 : 0: fixed speed setpoint 2 
• 0 : 1 : 1: fixed speed setpoint 3 
• 1 : 0 : 0: fixed speed setpoint 4 
• 1 : 0 : 1: fixed speed setpoint 5 
• 1 : 1 : 0: fixed speed setpoint 6 
• 1 : 1 : 1: fixed speed setpoint 7 

X X ✓ X 
16 SPD2 Level 
17 SPD3 Level 

18 TSET Level Torque setpoint selection. 
This signal can select two torque setpoint 
sources (one external torque setpoint, one 
fixed torque setpoint). 
• 0: external torque setpoint (Analog Input 

2) 
• 1: fixed torque setpoint 

X X X ✓ 

19 SLIM1 Level Speed limit selection. 
A combination of SLIM1 to SLIM2 can select 
four speed limit sources (one external speed 
limit, three internal speed limits). 
SLIM2 : SLIM1 
• 0 : 0: internal speed limit 1 
• 0 : 1: external speed limit (Analog Input 

1) 
• 1 : 0: internal speed limit 2 
• 1 : 1: internal speed limit 2 

✓ ✓ ✓ ✓ 
20 SLIM2 Level 
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No. Name Type Description Control mode 
PTI IPos S T 

21 POS1 Level Select position setpoint. 
A combination of the signals POS1 to POS3 
can select eight fixed position setpoint 
sources. 
POS3 : POS2 : POS1 
• 0 : 0 : 0: fixed position setpoint 1 
• 0 : 0 : 1: fixed position setpoint 2 
• 0 : 1 : 0: fixed position setpoint 3 
• 0 : 1 : 1: fixed position setpoint 4 
• 1 : 0 : 0: fixed position setpoint 5 
• 1 : 0 : 1: fixed position setpoint 6 
• 1 : 1 : 0: fixed position setpoint 7 
• 1 : 1 : 1: fixed position setpoint 8 

X ✓ X X 
22 POS2 Level 
23 POS3 Level 

24 REF Edge 
0→1 

Set reference point with digital input or ref-
erence cam input for reference approaching 
mode. 
• 0→1: reference input 

X ✓ X X 

25 SREF Edge 
0→1 

The reference approach will be started with 
the signal SREF. 
• 0→1 start reference approach 

X ✓ X X 

26 STEPF Edge 
0→1 

Step forward to the next fixed position set-
point. 
• 0→1 start step action 

X ✓ X X 

27 STEPB Edge 
0→1 

Step backward to the previous fixed position 
setpoint. 
• 0→1 start step action 

X ✓ X X 

28 STEPH Edge 
0→1 

Step to the fixed position setpoint 1. 
• 0→1 start step action 

X ✓ X X 

 

 

 Note 

When working in the torque control mode, the torque setpoint equals to 0 if CWE and CCWE 
are at the same status. For more information, please refer to SINAMICS V90, SIMOTICS S-
1FL6 Operating Instructions. 
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 Note 
Invalid circumstances for DI signals 
• When SINAMICS V-ASSISTANT is communicating with the drive or you are operating the 

drive on SINAMICS V-ASSISTANT, some DI signals are invalid: 
– When referencing by SINAMICS V-ASSISTANT, the DI signal SREF is invalid. 
– During trial run test, the DI signal SON is invalid; meanwhile, DI7 and DI8 are 

occupied by SINAMICS V-ASSISTANT. 
 

Direct signal map  
Force the following six signals to logical "1" signals with parameter p29300 (P_DI_Mat): 

● SON 

● CWL 

● CCWL 

● TLIM1 

● SPD1 

● TSET 

● EMGS 

The definition for p29300 is as follows: 
 

Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0 
EMGS TSET SPD1 TLIM1 CCWL CWL SON 

For example, if you set p29300 = 1 to force SON to a logical high signal, DI1 can then be 
assigned to other desired signals.  

 

 Note 

The parameter p29300 has higher priority than the DIs. 

The bit 6 of p29300 is used for emergency stop. You are not allowed to modify it when the 
drive is in the servo on state. 
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4.3.1.3 Digital outputs (DOs) 
You can assign a maximum of 13 internal digital output signals to the SINAMICS V90 servo 
drive. For detailed information about these signals, see the table below: 
 
No. Name Descriptions Control mode 

PTI IPos S T 
1 RDY Servo ready 

• 1: ready to operate 
• 0: drive not ready (alarm occurs or enable 

signal is missing) 

✓ ✓ ✓ ✓ 

2 FAULT Fault 
• 1: in fault status 
• 0: no fault 

✓ ✓ ✓ ✓ 

3 INP In-position signal 
• 1: number of droop pulses is in the preset in-

position range (parameter p2544) 
• 0: droop pulses are beyond the in-position 

range 

✓ ✓ X X 

4 ZSP Zero speed detection 
• 1: motor speed is equal with or lower than 

the zero speed (can be set with parameter 
p2161). 

• 0: motor speed is higher than zero speed + 
hysteresis (10 rpm). 

✓ ✓ ✓ ✓ 

5 SPDR Speed reached 
• 1: motor actual speed has nearly (internal 

hysteresis 10 rpm) reached the speed of the 
internal speed command or analog speed 
command. The speed approaching range 
can be set via parameter p29078 

• 0: speed difference between speed setpoint 
and actual is larger than internal hysteresis. 

X X ✓ X 

6 TLR Torque limit reached 
• 1: the generated torque has nearly (internal 

hysteresis) reached the value of the positive 
torque limit, negative torque limit or analog 
torque limit 

• 0: the generated torque has not reached the 
limit 

✓ ✓ ✓ X 

7 SPLR Speed limit reached 
• 1: the speed has nearly (internal hysteresis, 

10 rpm) reached the speed limit. 
• 0: the speed has not reached the speed 

limit. 

✓ ✓ ✓ X 
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No. Name Descriptions Control mode 
PTI IPos S T 

8 MBR Motor holding brake 
• 1: motor holding brake is closed 
• 0: motor holding brake is released 
Note: MBR is only status signal because the 
control and the power supply of the motor hold-
ing brake is realized with separate terminals. 

✓ ✓ ✓ ✓ 

9 OLL Overload level reached 
• 1: motor has reached the parameterizable 

output overload level (p29080 in % of rated 
torque, default: 100%, max: 300%) 

• 0: motor has not reached the overload level 

✓ ✓ ✓ ✓ 

10 WARNIN
G1 

Warning 1 condition reached 
• 1: parameterizable warning 1 condition has 

been reached. 
• 0: warning 1 condition has not been 

reached. 
See note below. 

✓ ✓ ✓ ✓ 

11 WARNIN
G2 

Warning 2 condition reached 
• 1: parameterizable warning 2 condition has 

been reached 
• 0: warning 2 condition has not been 

reached. 
See note below 

✓ ✓ ✓ ✓ 

12 REFOK Referenced 
• 1 = Referenced 
• 0 = Not referenced 

X ✓ X X 

13 CM_STA Current control mode 
• 1 = The second mode in five compound 

control modes (PTI/S, IPos/S, PTI/T, IPos/T, 
S/T) 

• 0 = The first mode in five compound control 
modes or four basic modes (PTI, IPos, S, T) 

✓ ✓ ✓ ✓ 
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Assigning warning signals to digital outputs  
You can assign two groups of warning signals to digital outputs with parameters p29340 (first 
group of warning signals active) and p29341 (second group of warning signals active). 
 
Setting (p29340/p29341) Warning conditions 
1 Overload protection: load factor is 85% of or above the motor utiliza-

tion. 
2 Braking resistor: capacity of the braking resistor is 85% of or above 

the resistor power rating. 
3 Fan alarm: fan has stopped for 1 second or longer. 
4 Encoder alarm 
5 Motor overheat: motor has reached 85% of the maximum allowed 

motor temperature. 
6 Lifetime detection: the life expectancy of the capacity or the fan is 

shorter than the specified time. 

If warning condition assigned to p29340 occurs, WARNING1 becomes ON. 

If warning condition assigned to p29341 occurs, WARNING2 becomes ON. 

4.3.1.4 Analog inputs (AIs) 
Two analog inputs in total are available:  

● AI1: linked with speed related signals. 

● AI2: linked with torque related signals. 

In different control modes, the analog inputs are linked with different signals: 
 
Control mode AI1 AI2 
Position (PTI and IPos) Not used Torque limitation 
S Speed setpoint Torque limitation 
T Speed limitation Torque setpoint 
PTI/S and IPos/S Not used in position control 

modes 
--> Speed setpoint in S mode 

Torque limitation 

PTI/T and IPos/T Not used in position control 
modes 
-->Speed limitation in T mode 

Torque limitation in position 
control modes 
--> Torque setpoint in T mode 

S/T Speed setpoint in S mode  
--> Speed limitation in T mode 

Torque limitation in S mode 
--> Torque setpoint in T mode 
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4.3.1.5 Analog outputs (AOs) 
Two parameters, p29350 (selects signal sources for AO1) and p29351 (selects signal 
sources for AO2), are used to select the source of analog output: 
 

Parame-
ter 

Value Source Value Source 

p29350 0 (de-
fault) 

Actual speed (reference 
p29060) 

7 Pulse input frequency (reference 100 
k) 

1 Actual torque (reference 3 × 
r0333) 

8 Pulse input frequency (reference 
1000 k) 

2 Speed setpoint (reference 
p29060) 

9 Remaining number of pulses (refer-
ence 1 k) 

3 Torque setpoint (reference 3 × 
r0333) 

10 Remaining number of pulses (refer-
ence 10 k) 

4 DC bus voltage (reference 
1000 V) 

11 Remaining number of pulses (refer-
ence 100 k) 

5 Pulse input frequency (refer-
ence 1 k) 

12 Remaining number of pulses (refer-
ence 1000 k) 

6 Pulse input frequency (refer-
ence 10 k) 

  

p29351 0 Actual speed (reference 
p29060) 

7 Pulse input frequency (reference 100 
k) 

1 (de-
fault) 

Actual torque (reference 3 × 
r0333) 

8 Pulse input frequency (reference 
1000 k) 

2 Speed setpoint (reference 
p29060) 

9 Remaining number of pulses (refer-
ence 1 k) 

3 Torque setpoint (reference 3 × 
r0333) 

10 Remaining number of pulses (refer-
ence 10 k) 

4 DC bus voltage (reference 
1000 V) 

11 Remaining number of pulses (refer-
ence 100 k) 

5 Pulse input frequency (refer-
ence 1 k) 

12 Remaining number of pulses (refer-
ence 1000 k) 

6 Pulse input frequency (refer-
ence 10 k) 
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4.3.1.6 Pulse train inputs (PTIs) 
The SINAMICS V90 servo drive supports two kinds of setpoint pulse train input forms: 

● AB track pulse 

● Pulse + Direction 

For both forms, positive logic and negative logic are supported: 
 
Pulse train 
input form 

Positive logic = 0 Negative logic = 1 
Forward (CW) Reverse (CCW) Forward (CCW) Reverse (CW) 

AB track 
pulse 

  
Pulse + 
Direction 

  

4.3.1.7 Pulse train encoder outputs (PTOs) 

Function 
A pulse train encoder output (PTO) which provides pulse signals can transmit the signals to 
the controller to realize a closed-loop control system inside the controller, or transmit them to 
another drive as pulse train setpoint for a synchronous axis. 

4.3.2 Testing motor 
Two sub-functions are available: 

● Jog (Page 79) 

● Position trial run (Page 80) 

4.3.2.1 Jog 
For detailed information about Jog function, refer to Section "Jog (Page 39)". 
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4.3.2.2 Position trial run 
In online mode, you can configure this function on the following panel: 

 
 

 Note 

Position trial run is only available in position control modes (PTI and IPos). 
 

Operating sequence 
 
 1. Enter the Jog speed. 

 2. Use this button to enable the Jog function. 
Note: 
After clicking this button, a warning message will appear. Click 

 in the message window to confirm executing ser-
vo-on. 

 
3. Click this button to rotate the motor clockwisely and the motor 

will reach the maximum position. 
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 4.  Obtain the maximum position by clicking this button on the 
right of the panel. 

 
5. Click this button to rotate the motor counter-clockwisely and 

the motor will reach the minimum position. 

 6. Obtain the minimum position by clicking this button on the left 
of the panel. 
Note: 
Make sure the actual position is within the scope. Otherwise, 
the position trial run cannot be started. 

 7. Use this button to disable the Jog function. 
Note: 
The Jog function must be disabled before position trial run is 
started. 

 8. Enter the moving distance and moving speed. 

 
9. Click this button to enable the trial run function. 

 10. Start trial run by clicking this button. Or otherwise, click the 
following button to stop trial run: 

 

 11. If necessary, click this button to move back to the previous 
position. 
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4.3.3 Optimizing drive 
You can select the desired tuning mode with the tabs on the following panel: 

 
 

 Note 

The one-button auto tuning function is valid for firmware version V1.04 and higher. 
 

Auto-tuning modes 

The SINAMICS V90 supplies two auto-tuning modes: one-button auto tuning and real-time 
auto tuning. The auto tuning function can optimize control parameters with ratio of machine 
load moment of inertia (p29022) and set suitable current filter parameters to suppress the 
machine resonance automatically. You can change the dynamic performance of the system 
by setting different dynamic factors. 

● One-button auto tuning 

– One-button auto tuning estimates the machine load moment of inertia and mechanical 
characteristics with internal motion commands. To achieve the desired performance, 
you can execute the process many times before you control the drive with the host 
controller. The maximum speed is limited by the rated speed. 

● Real-time auto tuning 

– Real-time auto tuning estimates the machine load moment of inertia automatically 
while the drive is running with the host controller command. After enabling the servo 
on (SON), the real-time auto tuning function stays effective for the servo drive. If you 
do not need to estimate the load moment of inertia continuously, you can disable the 
function when the system performance is acceptable. 
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4.3.3.1 One-button auto tuning 
 

 Note 

Before using the one-button auto tuning, move the servo motor to the middle of mechanical 
position to avoid approaching the actual machine position limit.  

 

With one-button auto tuning, the servo drive can automatically estimate the ratio of load 
moment of inertia. 

Pre-conditions for one-button auto tuning 

● The ratio of machine load moment of inertia is unknown and needs to be estimated. 

● The motor is allowed to rotate clockwise and counter clockwise. 

● The motor rotation position (p29027 defines that one revolution equals to 360 degree) is 
allowed by the machine. 

– For the motor with an absolute encoder: position limitation is defined by p29027 

– For the motor with an incremental encoder: the motor must be allowed to rotate freely 
about two rounds when tuning starts 

Implement the following steps to use the one-button auto tuning function: 
 
1. Select the dynamic factor in the following area: 

 
For more information about selecting the dynamic factor, refer to chapter "one-button 
auto tuning" in SINAMICS V90, SIMOTICS S-1FL6 Operating Instructions. 

2. Configure the test signal in the following area: 

 
Note: 
The recommended position amplitude (p29027) is 360°. 

3. Click the following button to configure the parameters for the one-button auto tuning 
function. 
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4. Set the parameters in the window below: 

 
Note: 
You can set the ratio of machine load moment of inertia (p29022) with the following 
methods: 
• Enter it manually if you have known the ratio of machine load moment of inertia 
• Estimate the ratio of manchine load moment of inertia with one-button auto tuning 

(p29023.2 = 1). When you have executed the one-button tuning many times and 
obtained a stable value of p29022, you can stop estimating it by setting p29023.2 = 
0. 

Parameter p29028 is available when the multi-axis interpolation function is activated 
(p29023.7 = 1). If the axes are used as the interpolation axes, you need to set the same 
pre-control time constants (p29028) for them. After tuning is completed, you need to 
manually set the same position loop gains (p29110 [0]) for them if the tuning results are 
different. 
The parameters in advanced settings window must be set carefully when the auto-tuning 
function is disabled (p29021 = 0). 

5. Click the following button to enable the function after the parameters are set. 

 

6. Click this button to start tuning. 
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7. After the tuning is completed, the tuning results window appears.  

 
Press this button to apply the tuning result. 

 
Press this button to abort the tuning result. 

 

8. Copy the tuned parameters from RAM to ROM to save them when the tuning is com-
pleted and the drive performance is acceptable. 

 

 Note 

After servo on, the motor will run with the test signal. 

When the one-button auto tuning process completes successfully, the parameter p29021 will 
be set to 0 automatically. You can also set the parameter p29021 to 0 before servo on to 
interrupt the one-button auto tuning. Before you save the parameters on the drive, make 
sure that p29021 has changed to 0. 

 

 Note 

Do not use the JOG function when you use the one-button tuning function. 
 

 Note 

After the one-button tuning function is activated, no operation will be allowed except the 
servo off and emergency stop.  

 

 Note 

After one-button auto tuning is activated, do not change other auto tuning related 
control/filter parameters since these parameters can be set automatically and your changes 
will not be accepted. 

 

 Note 

One-button auto tuning can cause some changes of the control parameters. When the 
system rigidity is low, this may lead to a situation that when you set EMGS = 0, the motor 
needs take long time to emergency stop. 
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Resonance suppression with one-button auto tuning (p29021=1, p29023.1=1) 
The resonance suppression function is used together with the one-button auto tuning 
function. The function is activated by default. 

The function can be activated/deactivated with bit 1 of p29023. 

Before you use the resonance suppression function with one-button auto tuning, make sure 
the load is mounted as required and the servo motor can rotate freely. When the one-button 
auto tuning process completes successfully, the servo drive automatically sets the following 
notch filter relevant parameters with actual machine characteristic. Four current setpoint 
filters can be activated at most. You can check the following parameters in the tuning result 
window. 
 
Parame-
ter 

Value range Default 
value 

Unit Description 

p1663 0.5 to 16000 1000 Hz Natural frequency of current notch filter 2 denominator. 
p1664 0.001 to 10 0.3 - Damp of current notch filter 2 denominator. 
p1665 0.5 to 16000 1000 Hz Natural frequency of current notch filter 2 numerator. 
p1666 0.0 to 10 0.01 - Damp of current notch filter 2 numerator. 
p1668 0.5 to 16000 1000 Hz Natural frequency of current notch filter 3 denominator. 
p1669 0.001 to 10 0.3 - Damp of current notch filter 3 denominator. 
p1670 0.5 to 16000 1000 Hz Natural frequency of current notch filter 3 numerator. 
p1671 0.0 to 10 0.01 - Damp of current notch filter 3 numerator. 
p1673 0.5 to 16000 1000 Hz Natural frequency of current notch filter 4 denominator. 
p1674 0.001 to 10 0.3 - Damp of current notch filter 4 denominator. 
p1675 0.5 to 16000 1000 Hz Natural frequency of current notch filter 4 numerator. 
p1676 0.0 to 10 0.01 - Damp of current notch filter 4 numerator. 

 

 

 Note 
Notch filter remains active when the resonance suppression function is activated 
automatically. 

After one-button tuning, four filters can be activated at most. You can deactivate the notch 
filters by setting the parameter p1656. 
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4.3.3.2 Real-time auto tuning 
 

 

 Note 

Under operating conditions that impose sudden disturbance torque during 
acceleration/deceleration or on a machine that its rigidity is poor, auto tuning may not 
function properly, either. In such cases, use one-button auto tuning or manual tuning to 
optimize the drive. 

 

With real-time auto tuning, the servo drive can automatically estimate the ratio of load 
moment of inertia and set the optimum control parameters. 

Pre-conditions for the real-time auto tuning 

● The drive must be controlled by the host controller. 

● The machine actual load moment of inertia is different when the machine moves to the 
different positions. 

● Make sure that the motor has multiple accelerations and decelerations. Step command is 
recommended. 

● Machine resonance frequency changes when the machine is running. 

Implement the following steps to use the real-time auto tuning function: 
 
1. Select the dynamic factor in the following area: 

 
For more information about selecting the dynamic factor, refer to chapter "Real-time 
auto tuning" in SINAMICS V90, SIMOTICS S-1FL6 Operating Instructions. 

2. Click the following button to configure the parameters for the real-time auto tuning func-
tion. 
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3. Set the parameters in the window below: 

 
Note: 
You can set the ratio of machine load moment of inertia (p29022) with the following 
methods: 
• Enter it manually if you have known the ratio of machine load moment of inertia 
• Use the ratio of machine load moment of inertia estimated by the one-button auto 

tuning function directly 
• Estimate the ratio of machine load moment of inertia with real-time auto tuning 

(p29024.2 = 1). When you have obtained a stable value of p29022, you can stop 
estimating it by setting p29024.2 = 0. 

Parameter p29028 is available when the multi-axis interpolation function is activated 
(p29024.7 = 1). If the axes are used as the interpolation axes, you need to set the same 
pre-control time constants (p29028) for them. After tuning is completed, you need to 
manually set the same position loop gains (p29110 [0]) for them if the tuning results are 
different. 
The parameters in advanced settings window must be set carefully when the auto-tuning 
function is disabled (p29021 = 0). 

4. Click the following button to start tuning after the parameters are set. 

 



 Task navigation 
 

SINAMICS V-ASSISTANT Online Help 
Operating Manual, 07/2015, A5E32187373-004 89 

5. Perform the servo on for the drive with host controller and tuning starts.  
For example, you can use the following method to run the motor. 
Implement servo on for the drive with Jog. 

 
Enter the speed for the motor and press the direction button to let the motor run.  

 

6. To achieve the desired system performance, you can change the dynamic factors or 
related configuration parameters during tuning. 

7. If the drive performance is acceptable, disable the tuning function by servo off and set 
p29021 = 0. 

8. Copy the tuned parameters from RAM to ROM to save them. 

Resonance suppression with real-time auto tuning (p29021=3, p29024.6=1) 
The resonance suppression function is used together with the real-time auto tuning function. 
The function is activated by default. 

When you use real-time auto tuning function, you are recommended to disable the 
resonance suppression function to get a high dynamic performance if there is no resonance 
in the machine. 

The function can be activated/deactivated with the bit 6 of p29024. 

When you choose to use the resonance suppression function with real-time auto tuning, the 
servo drive performs real-time detection of the resonance frequency and configures the 
following notch filter relevant parameters accordingly: 
 
Parame-
ter 

Value range Default 
value 

Unit Description 

p1663 0.5 to 16000 1000 Hz Natural frequency of current notch filter 2 denominator. 
p1664 0.001 to 10 0.3 - Damp of current notch filter 2 denominator. 
p1665 0.5 to 16000 1000 Hz Natural frequency of current notch filter 2 numerator. 
p1666 0.0 to 10 0.01 - Damp of current notch filter 2 numerator. 
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4.3.3.3 Manual tuning 
When the auto tuning function cannot reach the expected tuning results, you can disable the 
auto tuning function by setting the parameter p29021 and manually perform tuning: 

● p29021=5: auto tuning function is disabled and all control parameters are reset to tuning 
default values. 

● p29021=0: auto tuning function is disabled without changing control parameters. 

Parameter settings 
You can set the parameters on the following panel: 

 
Click  to reset the following parameters to their tuning defaults. The tuning 
default values of the parameters are different when you use the different drives and motors. 
The function of the button is not drive default so the tuning default values of the control 
parameters are different with their factory settings. 

● p1414 

● p1415 

● p1656 

● p1658 

● p1659 

● p2533 

● p29110[0] 
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● p29111 

● p29120[0] 

● p29121[0] 

Resonance suppression with manual tuning (p29021=0) 
When both the resonance suppression with real-time auto tuning and one-button tuning 
mode cannot reach the suppression effect, you can do the resonance suppression by 
manually setting the following parameters: 
 
Parame-
ter 

Value range Default 
value 

Unit Description 

p1663 0.5 to 16000 1000 Hz Natural frequency of current notch filter 2 denominator. 
p1664 0.001 to 10 0.3 - Damp of current notch filter 2 denominator. 
p1665 0.5 to 16000 1000 Hz Natural frequency of current notch filter 2 numerator. 
p1666 0.0 to 10 0.01 - Damp of current notch filter 2 numerator. 
p1668 0.5 to 16000 1000 Hz Natural frequency of current notch filter 3 denominator. 
p1669 0.001 to 10 0.3 - Damp of current notch filter 3 denominator. 
p1670 0.5 to 16000 1000 Hz Natural frequency of current notch filter 3 numerator. 
p1671 0.0 to 10 0.01 - Damp of current notch filter 3 numerator. 
p1673 0.5 to 16000 1000 Hz Natural frequency of current notch filter 4 denominator. 
p1674 0.001 to 10 0.3 - Damp of current notch filter 4 denominator. 
p1675 0.5 to 16000 1000 Hz- Natural frequency of current notch filter 4 numerator. 
p1676 0.0 to 10 0.01 - Damp of current notch filter 4 numerator. 

Assume the notch frequency is fsp, notch width is fBB, and notch depth is K, then the filter 
parameters can be calculated as follows: 

p1663=p1665=fsp 

p1664=fBB / (2 × fsp) 

p1666=(fBB × 10(k/20) )/ (2 × fsp) 
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Switching modes 
Two switching modes are available as follows: 

 
These two switching modes cannot be used at the same time. Once one mode is enabled, 
the other one will become disabled. The functions of auto-tuning and gain switching must be 
disabled so that the function of PI/P switching can be available. When the gain switching 
function is enabled, the PI/P switching function is disabled and the settings will not be 
cleared. 

● Gain switching 

Five gain switching modes in total are available:  

– Gain switching disabled 

– Gain switching using digital input signal (G-CHANGE) 

– Gain switching using position deviation 

– Gain switching using position setpoint frequency 

– Gain switching using actual speed 

If you select either of the last three gain switching modes, you need to set the conditional 
threshold. 
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● Speed loop PI/P switching 

Five switching modes in total are available for PI/P switching: 

– using torque setpoint 

– using an external digital input signal (G-CHANGE) 

– using speed setpoint 

– using acceleration setpoint 

– using pulse deviation 

If you select either of the PI/P switching modes (except the second mode), you need to 
set the conditional threshold. 

 
  Note 

PI/P switching 

Function of PI/P switching is not available for the T mode (torque control mode). 

The PI/P switching will respond with a delay time of several milliseconds. 
 

4.3.3.4 Low frequency vibration suppression 
Low frequency vibration suppression function is position setpoint filter function. It can 
suppression the vibration between 0.5 Hz to 62.5 Hz. The function is available in IPos control 
mode. 

Related parameters 
When you use the vibration suppression function, you need to configure the following 
parameters accordingly: 
 
Parameter Value 

range 
Default 
value 

Unit Description 

p29035 0 to 1 0 - Vibration suppression activation. 
• 0: disble 
• 1: enable 

p31581 0 to 1 0 - Vibration suppression filter type. 
• 0: filter type rugged 
• 1: filter type sensitive 

p31585 0.5 to 
62.5 

1 Hz Vibration suppression filter frequency. 

p31586 0 to 0.99 0.03 - Vibration suppression filter damp. 
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Operating steps  
 
1. Set the drive to servo off status. 
2. Go to "View all parameters" panel and set the related parameters. 

• Set the filter type by p31581. 
– 0: filter type rugged 
– 1: filter type sensitive 

• Set the suppression frequency by p31585. 
– You can set the suppression frequency from 0.5 Hz to 62.5 Hz. 

• Set damp of the filter by p31586. 
– You can set the damp from 0 to 0.99. 

3. Set control mode for the drive in the following panel. 

 

4. Enable the vibration suppression function by p29035 in "View all parameters" 
panel. 
• Set p29035 = 1 to activate the function. 

5. Set the drive to servo on status. 
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4.4 Diagnostics 

4.4.1 Monitoring status 
 

 Note 

This function can only work in online mode. 
 

You can monitor the real-time value of motion related parameters. The motion data and 
product information are displayed on the following panel: 
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4.4.2 Tracing signals 
With this function, you can trace the performance of the connected drive in the current 
control mode on the following panel: 

 
 
Area Item Description 

 

① Trace configu-
ration  

Opens the window of trace configuration. For more infor-
mation, refer to "Trace configuration (Page 99)". 

Start/stop trace  
(Only available 
in online mode) 

 
Starts recording the current trace.  
If you desire to stop the trace process, click the following 
button: 

 

② Cursors 
 

Changes the cursor shape from cross to arrow. 
When the cursor displays as an arrow, you can directly 
select a curve and use it for variable calculation.  
Note: 
The selected curve displays highlighted. 

 
If you click this button, you can move the selected curve 
freely after the cursor appears in the shape of a hand. 
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Area Item Description 
 

Auxiliary lines 
 

Vertical cursor: 
• In time domain chart, you can click this button to dis-

play coordinates t1 and t2 in the chart. You can move 
t1 or t2 when the cursor changes to . 

• In frequency domain chart, activate this button to 
display a highlighted coordinate in the chart. You can 
move this coordinate in the chart when the cursor 
changes to . 

 
Horizontal cursor: 
• In time domain chart, you can click this button to dis-

play coordinates y1 and y2 in the chart. You can 
move y1 or y2 when the cursor changes to . 

• In frequency domain chart, the button is not available. 

Zoom 
 

Zooms in the current curves with a specified scale. 

 
Zooms out the current curves with a specified scale. 

 
Restores curves in the chart. 

File operation 
 

 
Opens an existing .trc file for curve display in the chart. 

 
Saves the current recording of values as a .trc file. 

Note:  

In frequency domain chart, horizontal cursor button  is unavailable. 

③ Charts • Time domain chart: 

Displays the time chart in curves and records meas-
ured values of parameters. 

• Frequency domain chart: 

Available for mathematically computed curves and 
displays the Fourier transformation. 

④ Time domain chart 
T Coordinate T (time): 

• t1: Real-time value of coordinate t1 
• t2: Real-time value of coordinate t2 
• dt: Automatically calculated duration. 

The formula is as follows:  

dt = t2 - t1 
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Area Item Description 
 

Y Coordinate Y: 
• y1: Real-time value of coordinate y1 
• y2: Real-time value of coordinate y2 
• dy: Automatically calculated value range. 

The formula is as follows: 

dy = y2 - y1 
Y(T) • y(t1): Real-time value at the cross point of coordinate 

t1 and selected curve. 
• y(t2): Real-time value at the cross point of coordinate 

t2 and selected curve. 
• dy(t): Automatically calculated real-time value range. 

The formula is as follows: 

dy(t) = y(t2) - y(t1) 
Note: 
You can select a coordinate by clicking its designation, then the selected coordinate 
displays yellow. 
Frequency domain chart 
Frequency Displays real-time frequency value of the horizontal cur-

sor coordinate in the chart. 
Amplitude Displays real-time amplitude value at the cross point of 

the horizontal cursor coordinate and curve. 

⑤ Curve selection Selects a curve to display in the chart. 
• Time domain chart: 

A maximum of six curves can be simultaneously dis-
played in the chart. 

• Frequency domain chart: 

Only one curve can be selected to display in the 
chart. 
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4.4.2.1 Trace configuration 

 
 
Index Function description 

① Click the following button to select the analog signal. 

 
Select a trace signal and click  to confirm your selection. Or otherwise, 
you can click  to cancel. 
Click the color bar to define the display color of the curve for the signal. 

② Click the following button to select the digital signal. 

 
Select a trace signal and click  to confirm your selection. Or otherwise, 
you can click  to cancel. 
Click the color bar to define the display color of the curve for the signal. 

③ Recording settings: 
You can select the factor and define the trace cycle clock, maximum duration and 
recording duration. 
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Index Function description 

④ Seven trigger types are available for your selection: 
• Immediate recording (default settings) 
• Trigger on rising edge 

Note:  

The digital signals must be set to 1. Otherwise, the rising edge cannot be trig-
gered. 

• Trigger on falling edge 

Note:  

The digital signals must be set to 0. Otherwise, the falling edge cannot be trig-
gered. 

• Trigger within the scope 
• Trigger outside of the scope 
• Trigger at alarm 
• Trigger at fault 

Trigger type settings: 
• For the last six trigger types, you can select pre-trigger or post-trigger and the 

trigger signal. 
• For the fourth and fifth trigger types, you can enter the threshold upper/lower 

value in the textbox. 
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4.4.3 Measuring machine 
The measuring function is used for controller optimization. With measuring function, you can 
directly inhibit the influence of higher-level control loops by means of simple 
parameterization, and analyze the dynamic response of individual drives. 

For easier handling of the controller optimization, predefined measuring functions are 
available for selection. The operating mode is automatically set depending on the measuring 
function.  

● Speed controller setpoint frequency response(before speed setpoint filter) 

The speed control loop is closed while all of the higher-level control loops are open. For 
the setpoint frequency response on the speed controller, the speed setpoint is activated 
by a PRBS signal. The evaluation of the signals is performed in the frequency range. 

● Speed control system(excitation after current setpoint filter) 

The speed control loop is closed while all of the higher-level control loops are open. For 
the measurement of the speed controller system on the speed controller, the speed 
setpoint is activated by a PRBS signal. The evaluation of the signals is performed in the 
frequency range. 

● Current controller setpoint frequency response(after current setpoint filter) 

For the reference frequency response on the current controller, the current setpoint is 
activated by a PRBS signal. The evaluation of the signals is performed in the frequency 
range. 

 

 Note 

Measuring machine is only available in online mode. 
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Overview 

 
 
Area Item Description 

① Measuring functions • Speed controller setpoint frequency response(before speed setpoint filter) 
• Speed control system(excitation after current setpoint filter) 
• Current controller setpoint frequency response(after current setpoint filter) 

Amplitude The value of the signal amplitude to be applied. 
For the current controller, the specification is a relative value in percent. The 
value refers to the reference current (p2002). For the speed controller, the ampli-
tude specification is always in physical units. 

Offset DC component which is superimposed on the test signal. 
The value is normalized in the same way as the amplitude specification. Please 
note that the offset is subtracted again when the measured values are saved 
during runtime. 

Bandwidth Bandwidth of the measurement activated by a PRBS signal. 
Bandwidth = 1/(2*sample frequency). As only multiply of 2n for the minimum sam-
pling time (0.25ms) is available, the bandwidths that can be implemented are 
quantized. 
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Area Item Description 

② Servo on/off Click  and the following warning appears:  

 
Confirm by clicking  to obtain the control priority for the connected 
drive.  
Then  becomes . If you 
desire to give up the control priority, you can directly click it. 

Start trace 
 

Click this button to start trace. 
Note: 
During the trace process, you cannot stop it but only wait until it is complete. 

③ Cursor 
 

Changes the cursor shape from cross to arrow. When the cursor displays as an 
arrow, you can directly select a curve and use it for variable calculation.  
Note: 
The selected curve displays highlighted. 

 
If you click this button, you can move the selected curve freely after the cursor 
appears in the shape of a hand. 

Auxiliary line 
 

Vertical cursor: 
In time domain chart, you can click this button to display coordinates t1 and t2 in 
the chart. You can move t1 or t2 when the cursor changes to . 
In frequency domain chart, activate this button to display a highlighted coordinate 
in the chart. You can move this coordinate in the chart when the cursor changes 
to .  

 
Horizontal cursor: 
• In time domain chart, you can click this button to display coordinates y1 and 

y2 in the chart. You can move y1 or y2 when the cursor changes to . 
• In frequency domain chart, the button is not available. 

Zoom 
 

Zooms in the current curves with a specified scale. 

 
Zooms out the current curves with a specified scale. 

 
Restores curves in the chart. 

File operation 
 

Opens an existing .trc file for curve display in the chart. 

 
Saves the current recording of values as a .trc file. 
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Area Item Description 
Note:  

In frequency domain chart, horizontal cursor button  is unavailable. 

④ 
 

Chart • Time domain chart: 
Displays the time chart in curves and records measured values of parameters. 

• Frequency domain chart: 
Available for mathematically computed curves and displays the Fourier trans-
formation. 

• Bode diagram: 
Available for mathematically computed curves.  

⑤ Time domain chart 
T Coordinate T (time): 

• t1: Real-time value of coordinate t1 
• t2: Real-time value of coordinate t2 
• dt: Automatically calculated duration 
The calculation formula is as follows:  
dt = t2 - t1 

Y Coordinate Y: 
• y1: Real-time value of coordinate y1 
• y2: Real-time value of coordinate y2 
• dy: Automatically calculated value range 
The calculation formula is as follows: 
dy = y2 - y1 

Y(T) • y(t1): Real-time value at the cross point of coordinate t1 and selected curve. 
• y(t2): Real-time value at the cross point of coordinate t2 and selected curve. 
• dy(t): Automatically calculated real-time value range. 
The calculation formula is as follows: 
dy(t) = y(t2) - y(t1) 

Note: 
You can select a coordinate by clicking its designation, then the selected coordinate displays yellow. 
Frequency domain chart 
Frequency Displays real-time frequency value of the horizontal cursor coordinate in the 

chart. 
Amplitude Displays real-time amplitude value at the cross point of the horizontal cursor 

coordinate and curve. 
Bode diagram 
Frequency Displays real-time frequency value of the horizontal cursor coordinate in the dia-

gram. 
Amplitude Displays real-time amplitude value at the cross point of the horizontal cursor 

coordinate and the curve. 

⑥ Curve selection Selects a curve to display in the chart. 
• Time domain chart: 

A maximum of six curves can be simultaneously displayed in the chart. 
• Frequency domain chart: 

Only one curve can be selected to display in the chart. 
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4.5 Communicating with the PLC 
 

The SINAMICS V90 supports communication with the PLC on RS485 interface. You can 
parameterize whether the RS485 interface shall apply USS or Modbus RTU protocol. USS is 
the default bus setting. A shielded twisted pair cable is recommended for the RS485 
communication. 

4.5.1 USS communication 
The SINAMICS V90 can communicate with the PLC through an RS485 cable with the 
standard USS communication protocol. After the communication is established, you can 
change the position setpoint and speed setpoint through the USS communication protocol. 
The servo drive can also transmit the actual speed, torque, and alarm to the PLC through the 
USS communication protocol. 

Telegram format 
The telegram format is shown as follows: 

 
STX LGE ADR PKE IND PWE PWE BCC 

 STX: start of text 
LGE: length 
ADR: slave address 
PKE: parameter ID 
IND: sub-index 
PWE: parameter value 
BCC: block check character 

Relevant parameters 
You can access the following parameters by USS. 
 
Parameter Description Parameter Description 
p1001 Fixed speed setpoint 1 r0020 Speed setpoint smoothed 
p1002 Fixed speed setpoint 2 r0021 Actual speed smoothed 
p1003 Fixed speed setpoint 3 r0026 DC link voltage smoothed 
p1004 Fixed speed setpoint 4 r0027 Absolute actual current smoothed  
p1005 Fixed speed setpoint 5 r0031 Actual torque smoothed 
p1006 Fixed speed setpoint 6 r0032 Active power actual value smoothed 
p1007 Fixed speed setpoint 7 r0034 Motor utilization thermal 
p2617[0...7] Fixed position setpoint r0807 Master control active 
p2618[0...7] Speed of fixed position setpoint r2521 LR position actual vaule 
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Parameter Description Parameter Description 
p2572 IPos maximum acceleration r2556 LR position setpoint after setpoint 

smoothing 
p2573 IPos maximum deceleration   

 

 

 Note 

There is no priority when BOP, V-ASSISTANT, and USS access the same parameter at the 
same time, the value of the parameter depends on the last access operation. 

 

Operating steps  
 
1. Set the drive to servo off status. 
2. Go to "View all parameters" panel and set the related parameters. 

• Configure the RS485 bus address by parameter p29004. 
– You can configure the slaver address from 1 to 31. 

• Set the communication protocol by parameter p29007. 
– Set p29007 = 1 to use the USS protocol. 

• Set the transmission baud rate by parameter p29009. 
3. Set control mode for the drive in the following panel. 

 

4. Save the parameters and restart the drive. 
5. Access the parameters via USS. 

• For IPos control mode, you can change the following parameters via USS: 
– p2617[0...7], p2618[0...7], p2572, p2573 

• For S control mode, you can change the following parameter via USS: 
– p1001 to p1007 

• Ten monitor parameters can be read by USS: 
– r0020, r0021, r0026, r0027, r0031, r0032, r0034, r0807, r2556, and r2521 

 

 Note 

The USS protocol communication libraries of S7-200, S7-200 SMART V1.0, and S7-1200 do 
not support the communication with the SINAMICS V90 servo drive. 
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4.5.2 Modbus communication 
The SINAMICS V90 servo drive can communicate with the PLC through an RS485 cable 
with the standard Modbus communication protocol. For Modbus data format, V90 supports 
Modbus RTU while Modbus ASCII is not supported. Registers of the servo drive can be read 
by Modbus function code FC3 and written via function code FC6 (single register) or FC16 
(multiple registers). The SINAMICS V90 supports only three function codes. If a request with 
an unknown function code is received, an error message will be returned. 

Operating steps 
 
1. Set the drive to servo off status. 
2. Go to "View all parameters" panel and set the related parameters. 

• Configure the RS485 bus address by parameter p29004. 
– You can configure the slaver address from 1 to 31. 

• Set the communication protocol by parameter p29007. 
– Set p29007 = 2 to use the Modbus protocol. 

• Select the Modbus control source by parameter p29008. 
– p29008 = 1: Setpoint and control word from Modbus PZD 
– p29008 = 2: No control word. 

• Set the transmission baud rate by parameter p29009. 
3. Set control mode for the drive in the following panel. 

 

4. Save the parameters and restart the drive. 
5. Configure the PLC parameters. 

Note: 
Keep the PLC baud rate the same as the drive setting. 
Set even parity check for the PLC. 

6. Write the control word via the PLC. 
Note: 
Bit 10 of the register 40100 must be set to 1 to allow the PLC to control the drive. 
You need to trigger a rise edge for OFF1 to enable SON status for the motor, and 
OFF2 and OFF3 must be set to 1. The step must be executed when you enable 
SON for the first time. 

7. Write the setpoint and read the status word via PLC. 
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Example 

Here is an example which shows the operating procedures when we the use setpoint and 
control word from Modbus as the Modbus control source in S control mode.  
 
1. Set RS485 bus address for the drive. 

• p29004 = 1 
2. Select the Modbus protocol by p29007. 

• p29007 = 2 
3. Select Modbus control source by p29008. 

• p29008 = 1 
4. Set the transmission baud rate by p29009. 

• p29009 = 8 (38400 baud) 
5. Save the parameters and restart the drive. 
6. Set the drive work mode to S control mode. 
7. Configure the PLC parameters. 

 
Note: 
Keep the PLC baud rate the same as the drive setting. 
Set even parity check for the PLC (parity = 2). 
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8. Write the control word you desired via the register 40100. 

 
Note: 
Bit 10 of the register 40100 must be set to 1 to allow the PLC to control the drive. 
You need to trigger a rise edge for OFF1 to enable SON status for the motor, and 
OFF2 and OFF3 must be set to 1. The step must be executed when you enable SON 
for the first time. 
For example, we write 0x41E to the register 40100 firstly and then write 0x41F to the 
register. The motor now is in SON status. You can check the control word definition 
table below to see the meaning of "0x41E" and "0x41F". 

9. Write the speed setpoint via the register 40101. 

 
Note: 
You can calculate the actual speed value with the scale factor. Value 0x4000 repre-
sents the value of 100% × motor rated speed. Therefore, 0x2000 represents half of 
the motor rated speed. 



Task navigation  
 

 SINAMICS V-ASSISTANT Online Help 
110 Operating Manual, 07/2015, A5E32187373-004 

Mapping table 
The SINAMICS V90 servo drive supports the following registers. "R", "W", "R/W" in the 
column access stand for read, write, read/write. 

 
Modbus register 
number 

Description Modbus 
access 

Unit Scaling 
factor 

Range or 
On/Off text 

Data/parameter 

40100 Control word (PTI, IPos, 
S, T) 

R/W - 1 - Process data 1, receive 
word, PZD1 

40101 Speed setpoint (S) R/W - 0x4000 hex 
= 100% × 
motor rated 
speed 

- Process data 2, receive 
word, PZD2 

40102 Position setpoint high-
word (IPos) 

R/W LU 1 -2147482648 to 
2147482647 

Process data 3, receive 
word, PZD3 

40103 Position setpoint low-
word (IPos) 

R/W LU 1 Process data 4, receive 
word, PZD4 

40110 Status word (PTI, IPos, 
S, T) 

R - 1 - Process data 1, send 
word, PZD1 

40111 Actual speed (PTI, 
IPos, S, T) 

R - 0x4000 hex 
= 100% × 
motor rated 
speed 

- Process data 2, send 
word, PZD2 

40112 Actual position high-
word (PTI, IPos) 

R LU 1 -2147482648 to 
2147482647 

Process data 3, send 
word, PZD3 

40113 Actual position low-
word (PTI, IPos) 

R LU 1 Process data 4, send 
word, PZD4 

40200 DO 1 R/W - 1 HIGH/LOW r0747.0 
40201 DO 2 R/W - 1 HIGH/LOW r0747.1 
40202 DO 3 R/W - 1 HIGH/LOW r0747.2 
40203 DO 4 R/W - 1 HIGH/LOW r0747.3 
40204 DO 5 R/W - 1 HIGH/LOW r0747.4 
40205 DO 6 R/W - 1 HIGH/LOW r0747.5 
40220 AO 1 R % 100 -100.0 to 100.0 - 
40221 AO 2 R % 100 -100.0 to 100.0 - 
40240 DI 1 R - 1 HIGH/LOW r0722.0 
40241 DI 2 R - 1 HIGH/LOW r0722.1 
40242 DI 3 R - 1 HIGH/LOW r0722.2 
40243 DI 4 R - 1 HIGH/LOW r0722.3 
40244 DI 5 R - 1 HIGH/LOW r0722.4 
40245 DI 6 R - 1 HIGH/LOW r0722.5 
40246 DI 7 R - 1 HIGH/LOW r0722.6 
40247 DI 8 R - 1 HIGH/LOW r0722.7 
40248 DI 9 R - 1 HIGH/LOW r0722.8 
40249 DI 10 R - 1 HIGH/LOW r0722.9 
40260 AI 1 R % 100 -300.0 to 300.0 - 
40261 AI 2 R % 100 -300.0 to 300.0 - 



 Task navigation 
 

SINAMICS V-ASSISTANT Online Help 
Operating Manual, 07/2015, A5E32187373-004 111 

Modbus register 
number 

Description Modbus 
access 

Unit Scaling 
factor 

Range or 
On/Off text 

Data/parameter 

40280 Enable DI simulation 
(high part) 

R/W - 1 HIGH/LOW - 

40281 Enable DI simulation 
(low part) 

R/W - 1 HIGH/LOW - 

40282 Setpoint DI simulation 
(high part) 

R/W - 1 HIGH/LOW - 

40283 Setpoint DI simulation 
(low part) 

R/W - 1 HIGH/LOW - 

40300 Power stack code num-
ber 

R - 1 0 to 32767 - 

40301 V90 OA version R - 1 e.g. 104xx for 
V01.04.xx 

p29018[0]/10000 

40320 Rated power of the 
power unit 

R kW 100 0.00 to 327.67 - 

40321 Current limit R/W % 10 10.0 to 400.0  - 
40322 Ramp-up time R/W s 100 0.0 to 650.0 p1120 
40323 Ramp-down time R/W s 100 0.0 to 650.0 p1121 
40324 Reference speed R rpm 1 6 to 32767 Motor rated speed 
40325 Control mode R/W - 1 0 to 8 p29003 
40340 Speed setpoint R rpm 1 -16250 to 

16250 
r0020 

40341 Actual speed value R rpm 1 -16250 to 
16250 

r0021 

40344 DC-link voltage R V 1 0 to 32767 r0026 
40345 Actual current value R A 100 0 to 163.83 r0027 
40346 Actual torque value R Nm 100 -325.00 to 

325.00 
r0031 

40347 Actual active power R kW 100 0 to 327.67 r0032 
40348 Energy consumption R kWh 1 0 to 32767 - 
40349 Control priority R - 1 Manual/Auto r0807 
40350/40351 Position setpoint R LU 1 -2147482648 to 

2147482647 
r2556 

40352/40353 Actual position value R LU 1 -2147482648 to 
2147482647 

r2521[0] 

40354 Motor utilization R % 100 -320.00 to 
320.00 

r0034 

40400 Failure number, index 0 R - 1 0 to 32767 - 
40401 Failure number, index 1 R - 1 0 to 32767 - 
40402 Failure number, index 2 R - 1 0 to 32767 - 
40403 Failure number, index 3 R - 1 0 to 32767 - 
40404 Failure number, index 4 R - 1 0 to 32767 - 
40405 Failure number, index 5 R - 1 0 to 32767 - 
40406 Failure number, index 6 R - 1 0 to 32767 - 
40407 Failure number, index 7 R - 1 0 to 32767 - 
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Modbus register 
number 

Description Modbus 
access 

Unit Scaling 
factor 

Range or 
On/Off text 

Data/parameter 

40408 Alarm number R - 1 0 to 32767 - 
40800/40801 Fixed position setpoint 

1 
R/W LU 1 -2147482648 to 

2147482647 
p2617[0] 

40802/40803 Fixed position setpoint 
2 

R/W LU 1 -2147482648 to 
2147482647 

p2617[1] 

40804/40805 Fixed position setpoint 
3 

R/W LU 1 -2147482648 to 
2147482647 

p2617[2] 

40806/40807 Fixed position setpoint 
4 

R/W LU 1 -2147482648 to 
2147482647 

p2617[3] 

40808/40809 Fixed position setpoint 
5 

R/W LU 1 -2147482648 to 
2147482647 

p2617[4] 

40810/40811 Fixed position setpoint 
6 

R/W LU 1 -2147482648 to 
2147482647 

p2617[5] 

40812/40813 Fixed position setpoint 
7 

R/W LU 1 -2147482648 to 
2147482647 

p2617[6] 

40814/40815 Fixed position setpoint 
8 

R/W LU 1 -2147482648 to 
2147482647 

p2617[7] 

40840/40841 Speed of the fixed posi-
tion 1 

R/W 1000 
LU/min 

1 1 to 40000000 p2618[0] 

40842/40843 Speed of the fixed posi-
tion 2 

R/W 1000 
LU/min 

1 1 to 40000000 p2618[1] 

40844/40845 Speed of the fixed posi-
tion 3 

R/W 1000 
LU/min 

1 1 to 40000000 p2618[2] 

40846/40847 Speed of the fixed posi-
tion 4 

R/W 1000 
LU/min 

1 1 to 40000000 p2618[3] 

40848/40849 Speed of the fixed posi-
tion 5 

R/W 1000 
LU/min 

1 1 to 40000000 p2618[4] 

40850/40851 Speed of the fixed posi-
tion 6 

R/W 1000 
LU/min 

1 1 to 40000000 p2618[5] 

40852/40853 Speed of the fixed posi-
tion 7 

R/W 1000 
LU/min 

1 1 to 40000000 p2618[6] 

40854/40855 Speed of the fixed posi-
tion 8 

R/W 1000 
LU/min 

1 1 to 40000000 p2618[7] 

40880/40881 IPos maximum acceler-
ation 

R/W 1000 
LU/s2 

1 1 to 2000000 p2572 

40882/40883 IPos maximum decel-
eration 

R/W 1000 
LU/s2 

1 1 to 2000000 p2573 

40884/40885 EPos jerk limiting R/W 1000 
LU/s3 

1 1 to 100000000 p2574 

40900 Fixed speed setpoint 1 R/W - 0x4000 hex 
= 100% × 
motor rated 
speed 

-210000.000 to 
210000.00 

p1001 

40901 Fixed speed setpoint 2 R/W - 0x4000 hex 
= 100% × 
motor rated 
speed 

-210000.000 to 
210000.00 

p1002 
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Modbus register 
number 

Description Modbus 
access 

Unit Scaling 
factor 

Range or 
On/Off text 

Data/parameter 

40902 Fixed speed setpoint 3 R/W - 0x4000 hex 
= 100% × 
motor rated 
speed 

-210000.000 to 
210000.00 

p1003 

40903 Fixed speed setpoint 4 R/W - 0x4000 hex 
= 100% × 
motor rated 
speed 

-210000.000 to 
210000.00 

p1004 

40904 Fixed speed setpoint 5 R/W - 0x4000 hex 
= 100% × 
motor rated 
speed 

-210000.000 to 
210000.00 

p1005 

40905 Fixed speed setpoint 6 R/W - 0x4000 hex 
= 100% × 
motor rated 
speed 

-210000.000 to 
210000.00 

p1006 

40906 Fixed speed setpoint 7 R/W - 0x4000 hex 
= 100% × 
motor rated 
speed 

-210000.000 to 
210000.00 

p1007 

40932/40933 MDI speed of position 
setpoint 

R/W 1000 
LU/min 

1 1 to 
2147482647 

- 

40934 MDI acceleration over-
ride 

R/W % 100 0.1 to 100 - 

40935 MDI deceleration over-
ride 

R/W % 100 0.1 to 100 - 

40950 Fixed torque setpoint R/W % 100 -100 to 100 p29043 

Process data overview 
 
Control mode PTI IPos S T 
Control 
data 

40100 PTI mode control word IPos mode control word S mode control word T mode control word 
40101 - - Speed setpoint - 
40102 - Position setpoint high 

word 
- - 

40103 - Position setpoint low 
word 

- - 

Status 
data 

40110 Status word Status word Status word Status word 
40111 Actual speed Actual speed Actual speed Actual speed 
40112 Actual position high 

word 
Actual position high 
word 

- - 

40113 Actual position low 
word 

Actual position low 
word 

- - 
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Definition of the register 40100 
 

Bit PTI control mode IPos control mode 
Signals Description Signals Description 

0 SON_OFF1 Rising edge to enable SON (pulses can 
be enabled). 
0: OFF1 (braking with ramp-function 
generator, then pulse cancellation, ready 
to power up) 

SON_OFF1 Rising edge to enable SON (pulses can 
be enabled). 
0: OFF1 (braking with ramp-function 
generator, then pulse cancellation, ready 
to power up) 

1 OFF2 1: No OFF2 (enable is possible) 
0: OFF2 (immediate pulse cancelation 
and power on inhibit) 

OFF2 1: No OFF2 (enable is possible) 
0: OFF2 (immediate pulse cancelation 
and power on inhibit) 

2 OFF3 1: No OFF3 (enable is possible) 
0: OFF3 (fast braking then pulse cancela-
tion and power on inhibit) 

OFF3 1: No OFF3 (enable is possible) 
0: OFF3 (fast braking then pulse cancela-
tion and power on inhibit) 

3 OPER 1: Enable operation (pulses can be ena-
bled) 
0: Inhibit operation (cancel pulses) 

OPER 1: Enable operation (pulses can be ena-
bled) 
0: Inhibit operation (cancel pulses) 

4 Reserved - SETP_ACC Rising edge to accept MDI setpoint 
5 Reserved - TRANS_TY

PE SE 
1: Accept new setpoint immediately 
0: Accept on rising edge of SETP_ACC  

6 Reserved - POS_TYP 1: Absolute positioning 
0: Relative positioning 

7 RESET Reset faults RESET Reset faults 
8 Reserved - Reserved - 
9 Reserved - Reserved - 
10 PLC Enable master control from the PLC PLC Enable master control from the PLC 
11 Reserved - Reserved - 
12 Reserved - Reserved - 
13 Reserved - SREF Start referencing (act as REF for refer-

ence mode 0) 
14 Reserved - Reserved - 
15 Reserved - Reserved - 

 

 
Bit S control mode T control mode 

Signals Description Signals Description 
0 SON_OFF1 Rising edge to enable SON (pulses can 

be enabled). 
0: OFF1 (braking with ramp-function 
generator, then pulse cancellation, ready 
to power up) 

SON_OFF1 Rising edge to enable SON (pulses can 
be enabled). 

1 OFF2 1: No OFF2 (enable is possible) 
0: OFF2 (immediate pulse cancelation 
and power on inhibit) 

OFF2 1: No OFF2 (enable is possible) 
0: OFF2 (immediate pulse cancelation 
and power on inhibit) 
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Bit S control mode T control mode 
Signals Description Signals Description 

2 OFF3 1: no OFF3 (enable is possible) 
0: OFF3 (fast braking then pulse cancela-
tion and power on inhibit) 

OFF3 1: no OFF3 (enable is possible) 
0: OFF3 (fast braking then pulse cancela-
tion and power on inhibit) 

3 OPER 1: Enable operation (pulses can be ena-
bled) 
0: Inhibit operation (cancel pulses) 

OPER 1: Enable operation (pulses can be ena-
bled) 
0: Inhibit operation (cancel pulses) 

4 EN_PAMP 1: Operating condition (the ramp function 
generator can be enabled) 
0: Inhibit ramp function generator (set the 
ramp function generator output to zero) 

Reserved - 

5 Reserved - Reserved - 
6 Reserved - Reserved - 
7 RESET Reset faults RESET Reset faults 
8 Reserved - Reserved - 
9 Reserved - Reserved - 
10 PLC Enable master control from the PLC PLC Enable master control from the PLC 
11 Rev Direction of rotation reversal Reserved - 
12 Reserved - Reserved - 
13 Reserved - Reserved - 
14 Reserved - Reserved - 
15 Reserved - Reserved - 

 

 

 Note 

The following signals are occupied by Modbus control word when you use the setpoint and 
control word from Modbus as the Modbus control source (p29008 = 1). They can only be 
enabled by Modbus control word while cannot be enabled by DI terminals. 
• PTI control mode: SON 
• IPos control mode: SON, SREF (REF for reference mode 0) 
• S control mode: SON, CWE/CCWE 
• T control mode: SON 

 

 Note 

All the reserved bits in register 40100 must be set to 0. 
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Definition of register 40110 
 

Bit PTI, IPos, S and T control modes 
Signals Description 

0 RDY Servo ready 
1 FAULT Fault status 
2 INP In-position signal 
3 ZSP Zero speed detection 
4 SPDR Speed reached 
5 TLR Torque limit reached 
6 SPLR Speed limit reached 
7 MBR Motor holding brake 
8 OLL Overload level reached 
9 WARNING 1 Warning 1 condition reached 

10 WARNING 2 Warning 2 condition reached 
11 REFOK Referenced 
12 MODE 2 In the second control mode 
13 Reserved - 
14 Reserved - 
15 Reserved - 

Parameter scaling 
Due to the limits of the integer data in the Modbus protocol, it is necessary to convert the 
drive parameters before transmitting them. This is done by scaling, so that a parameter, 
which has a position after decimal point, is multiplied by a factor, to get rid of the fractional 
part. The scaling factor is as defined in the above table. 
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R 
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Reset drive, 25 
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